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Edilonial
Welcome to the 23rd
issue of 2DArtist
magazine. We have
a jam-packed issue
for you this month,
including not one
but three artists
giving their individual
interpretations of
our Speed Painting
Challenge topic! Turn

to page 93 to see how

the very talented Emrah

Elmasli, Mike Corriero

and Mikko Kinnunen

have all tackled the brief, “The citizens of the flooded city now resided in

the tallest buildings connected by makeshift bridges”. Also, don’t miss

Anne Pogoda’s latest instalment on page 118, where she teaches us “how

to paint lips worth kissing”! (Be sure to check out Anne’s previous tutorials

for 2DArtist in our back issues 19 and 20, where she taught us how to paint

beautiful hair.) We have a special feature on the ingenious new Infinite Oz

website, which is well worth a look on page 49 (be sure to see the website,

too: http://lwww.scifi.com/tinman/oz/). It's pretty much inspiration all-

round this month, with four great interviews with a diverse range of artists,

plus so much more! So get your Wacom out and start painting!

Enjoy! Ed.

dilon  (ondent

Lynette Clee

Designen

Chris Perrins

Tom Greenway
Lynette Clee
Warin Greenway
Richard Tilbury
Chris Perrins

Layoal  Inee Slufff?
Bobby Brown Wherever you see

Lynette Clee

this symbol, click it to
download resources,

extras and even

movies!

Mayazina y[&l[l‘ﬁl} m For optimum viewing of the magazine it is recommended that you have the

latest Acrobat Reader installed. Download it for free, here: DOWNLOAD. To view the many double-page spreads featured
in 2DArtist magazine, you can set the reader to display ‘two-up’, which will show double-page spreads as one large,

landscape image. 1. Open the magazine in Reader; 2. Go to the ‘View’ menu, then ‘Page display’; 3. Select ‘Two-up
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Every month, many creatives and artists from around the world contribute
to 3DCreative & 2DArtist Magazine. Here you can read all about them. If

you would like to be a part of 3DCreative or 2DArtist Magazines,

please contact: lynette@zoopublishing.com.

&lena
dedova

Is a New York based artist.
Elena has over 15 years of

work experience. She draws

illustrations for magazines and

children’s books. In her art, she uses variety of styles
and techniques. Elena creates animated characters
and brings them to live. Her unique artistic abilities
have also been shown in many art galleries all over

the world!

info@rabbitteam.com

www.elenasedova.com

Y/, 4 7//A
Has over 8 years of creative
visualisation and pre-production

experience, having worked

on various independent game
projects, publications and CGI pre-production
artwork. He is currently the CEO of his own digital art
studio, Opus Artz, based in London. Previous work
includes his role as Senior Concept Artist and Visual
Lead for ‘Infinity: The Quest for Earth MMO 2009’,
plus numerous commercial publications.

chee@opusartz.com

Www.opusartz.com

Is a freelance illustrator

and designer residing in

Los Angeles. He acts as an

integral part of many exciting
projects all around the world, which include themed
entertainment, films and video games. He is currently
focusing on Production Design for feature films,

as well as continuing to work with clients to design

meaningful spaces on various freelance projects.

nathanielbwest@aol.com

www.nathanielwest.net

Dusayne Woulbd You Like To Lontribule Tr
Vance Dbrealive On 2D list Magazine?

Has worked professionally as a . ) . L .
P y We are always looking for tutorial artists, gallery submissions, potential

designer for companies such as . . . . . .
9 P interviewees, Making Of writers and more. For more information, send a

Mattel in Hot Wheels, and has link to your work here: lynette@zoopublishing.com.

also designed protective gear

for Troy Lee Designs. Now he has his own company,
called “FutureElements”, and creates work for the
motorsports, entertainment and auto industries.

He also has his own line of Hot Rod art which is
influenced by his concept design background. For
more info on his company, check out his website!

www.futureelements.net

vancedwa@sbcglobal.net
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Is an Environment and Concept
Artist for Recoil Games in

Finland. He currently works in

the games industry where he
specialises in creating environment concepts and
in-game 3D assets for next-gen platforms. He'’s

currently living in Helsinki, Finland.

mikko@artbymikko.com

http://www.artbymikko.com

17 /HM

Is a multimedia developer
residing out in Denver,

Colorado. His career as an

artist has spanned over the last
14 years and includes work in both traditional and
digital media, web design, print, and motion graphics
for broadcasting. His client list is varied and ranges
from commissioned work for small studio projects to
larger clients such as Future Publishing, Burrows &
Chapin, The Ayzenberg Group, NASCAR, Dodge,
Toyota and Fox Television.

joelcarlo@gmail.com www.joelcarlo.net

Is a 2D artist working on

concepts, illustrations and

such. She graduated from the

Art Akademy and now works

freelance in Berlin, Germany. Anne made her first
attempts at digital art in 2003. For 3 years she has
been working on 2D illustrations and concept art with
a Wacom Graphire in Photoshop and Painter. She
will also be learning ZBrush 3 and Maya and would
like to do some game or film related stuff later.
wpwebmasterin@web.de

www.darktownart.de

Is a Turkish Concept Artist
based in London, UK. He's

working at Lionhead Studios

as a full-time Senior Concept
Artist. Before coming to UK, he was a freelance
artist living in Istanbul, Turkey, and was working

for various clients like Crystal Dynamics, Irrational
Games, CGToolkit and Fantasy Flight Games,

as well as ad agencies in Istanbul. He then found
himself in the UK. He draws everyday and enjoys the
city in his spare time.

emrah@partycule.com www.partycule.com

Daarken

After graduating from the
Academy of Art University in
San Francisco with a BFA in

traditional illustration, Daarken

began his career by freelancing
with several game companies, such as Wizards

of the Coast, Fantasy Flight Games, Widescreen
Games, Digital Extremes, and Upperdeck. He now
works for EA Mythic as a concept artist for the game,

Warhammer Online: Age of Reckoning.

daarkenart@daarken.com

http://www.daarken.com/

Is a Freelance Concept Artist
& lllustrator from NJ, USA.

Currently, Mike produces assets

as a Freelance artist for various

companies, including everything

from creatures, environments, structures, illustrations
and icons. His work has been featured in a number
of promotional outlets including ImagineFX, Ballistic
Publishing’s Expose 4 and 5 and Painter Book, Corel
Painter X and Design 360 (China).
mikecorriero@gmail.com

www.mikecorriero.com
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David

Started using Photoshop whilst
doing his lllustration degree in

Hull, UK, & has taught himself

from there onwards. After

graduating in 2005, he has worked as a freelance
consultant for EA games, sold prints in galleries,

& has completed various freelance projects in the
illustration field. Now represented by Advocate
lllustration Agency, he hopes to get more work on
children’s books & would also like to move into
concept design for animation at some point in future.

davejneale@hotmail.com

Is a Production/Concept Artist

at PitchiPoy Animation Studios,

Tel-Aviv, in Israel. He's been

drawing & painting since he can
remember; creating characters, creatures & fantastic
scenes has always been a passion of his. Telling a
whole story through a single image can be quite a
challenge, but he’s always up for it! Keeping his work
fresh & versatile, he explores all sorts of genres,
styles & attitudes.

Pat2005b@hotmail.com
http://chuckmate.blogspot.com

Is a freelance artist who
graduated from Amarillo

College with a degree in

Graphic Design. He's been

drawing and painting since middle school and has
worked with 3D tools before, but his main interest
is in digital painting. He loves watching things come
alive with each brush-stroke. He tries to sharpen
his skills by taking part in painting competitions on
ConceptArt.org.

noiinthavong@hotmail.com

www.3thumbsup.Ocatch.com
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Brian

Is currently working at
LucasArts in San Francisco as

a 3D Environment Artist. He

graduated from the Savannah

College of Art & Design with a concentration in Visual
Effects. Even though his focus is on 3D content
creation, he has a strong foundation and passion

for painting both on canvas and digitally. In his 2D
and 3D works, he attempts to tell a story using a
cinematic approach.

breckten@gmail.com

www.brianrecktenwald.com

image by Nathaniel West
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Elena Sedova was born and grew up in Russia.
She finished art school and art college, and
then went on to graduate from the Academy of
Arts. She is now living in New York where she
creates characters, illustrations for children’s
books, and her own personal artistic projects.
Read on to find out what makes Elena tick as
an artist and what we can expect from her in the

future...



elena
Sedova

Hello Elena, can you tell us a bit about what has

led you to where we find you today?

Hey! At present, I'm living in New York, USA.

I love New York! All my life | dreamt about this
city, and about a year ago or so my wishes
finally came true! So | am truly happy now. |
work as a freelancer; | am trying to enjoy my job
and | do only what | really like to, which is mostly
character creation, illustrations for children’s

books and my personal artistic projects.

Actually, everything began in Russia, where
| was born and grew up. My parents are also
artists so | didn’t have too many options when
choosing my occupation. Besides, I've always

liked drawing ever since the moment | was born.

In Russia, | finished art school and art college,

and | am also a graduate from the Academy

of Arts. Actually, | was meant to become a
classical artist, to paint on canvas using real oil
and acrylic colours, but | always liked computers
so | decided to become a graphic designer and
went to work for an advertising agency, instead.
My drawing skills were then forgotten for the

following few years.

One day, | realised that | couldn't take it any
more, and that | couldn’t be a designer - it’s all
too boring for me! From that point onwards, |
wanted to become an artist-illustrator, and to
spend time doing those things that | like the

most in my life.
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Your portfolio (www.elenasedova.com)
demonstrates a variety of different styles and
techniques. Can you talk us through your
favourite method, from the concept through to
the finished piece?

| have no specific style in my art; | have no
boundaries; all the time | am trying to vary and
expand my artistic abilities and try something

new. This probably happens because | hate

routine, not only in my art but in my personal
life, too. | also like to make changes quite
often. | like to invent new drawing styles

and techniques; sometimes | prefer to work
in a vector-based application, sometimes

just in Photoshop. In my opinion, technical
implementation of the idea is not as important
as the mood and spirit of the artwork itself. As

for me, the most interesting part of my work is to

DALV

lneveweLena

image: Fiery Jack

bring an idea or a character to life — the rest is
just a routine job. Speaking about my favourite
and most desirable application for 99% of my
sketches, drafts and illustrations, though, it is

always Photoshop! Photoshop forever!

For example, in the image titled “Fiery Jack”, the
sketch was drawn in Photoshop and finished in
Adobe lllustrator. Sometimes | draw the quick,
rough sketches — it doesn’t take too much time
but it helps me to lay down some of the ideas
that run in my head and to catch the right mood.
| hope to complete them later, but unfortunately,

very often, the sketches remain uncompleted.

| must confess that the way in which | work is
not exactly the ‘right’ way. For me, the major
points in my art are the character, the mood

and the inspiration, but not the composition

or layout of the drawing. That's why, in my
illustrations, the “hero” comes first and then |
work on the environment that actually has to
highlight the character's mood. During this long
process many interesting details are discovered
that take a very valuable part in my drawing...
but certainly not ‘less valuable’ than the main
composition. | also like to add some little “spicy”
nuances, which are perhaps not noticeable upon
first glance but later on you can learn a lot about

the character from them!

Let’s take the following illustration, of an old
man holding a lizard, as an example to discuss
the creation of one of my artworks... For the last

couple of years, | haven't used pencil and paper.
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From start to finish, | do everything using my Wacom tablet and Adobe
Photoshop. So | create a new document in Photoshop and choose the
background colour. Then the sketch is drawn. Quite often | do not bother
myself by drawing black and white drafts; the coloured sketches come

out straight away! Usually | take certain details, like a nose or an eye, as

a starting point for my drawing, and then follow up on that. This artwork is

actually a human portrait; he likes nature and animals but it looks like he’s
so much into his job that he has actually started looking like his chameleon

— they almost have the same face!

Issue 023 November 2007
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you can see, first of all | choose the background
and the colour palette, then the character
appears, but in initial sketches there was actually
no idea of a chameleon — he showed up later on.
| have to admit that very often when I'm drawing,
| have no idea where it's going to lead me in the
end. For example, all of a sudden the chameleon
decided to lick his owner’s wart (he got confused
and thought it was a fly!). Also, | thought about
adding a cage behind the man, but | changed my

mind and left the background clean in the end.

Your characters appear to be rather cute,
cheerful and happy, whereas your illustrations
and drawings can often reflect a more
melancholy state. What type of emotion do you
prefer to illustrate, and why? Would you say
that your personal mood directly influences your
artwork?

| can’t say that | have any preferences; |

don’t think | like something more or less

than another... Sadness and happiness: |

like to display both of these emotions in my
illustrations; | like to display a wide variety of
human emotions, human moods, and it doesn't
matter whether it's sad or happy or cheerful or

crazy or whatever else it is!

What is going to be the next ‘masterpiece’?
It always depends on my mood. Sometimes it
is upside down; when I'm in a bad mood and

| desperately need to create something really
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funny and cheerful. Anyway, all of my art comes from the bottom of my
heart; | am always concerned about my characters; my feelings and
emotions may come from the present time or from the past. Sometimes
it's much easier for me to express myself through my illustrations

than verbally. Thank god | have my skills, because words cannot say

everything!

Overall, I'd say your art creations are very expressive, energetic and lively.
Are these characteristics which you also possess yourself?

Yes, | think we have something in common! Although | am not flying
around my apartment like the cat in my “Crazy Cat” artwork, | do like
people with a sense of humour and | consider myself to be one of them.

In this job it is very difficult to take everything seriously. In my childhood

www.2dartistmag.com page 12 Issue 023 November 2007


http://www.2dartistmag.com
http://www.2dartistmag.com

| was a “hooligan-girl”, and my friends were
mostly boys. | like moving about and | enjoy
sports, but | don’t always have enough time

for it. It's very difficult to judge myself, but
people who | am in touch with say that | and my

characters are very alike.

From the moment | was a child | dreamt of
making cartoons, and unfortunately this is still
the dream... But, if | ever get the chance to work
with Pixar Animation artists, then | won’t miss

it! An opportunity like that is worth dying for!!

| love their characters and animations! Being
realistic though, | would like to participate in any

sort of crazy, unusual projects... which could be

anything where | can create and express my

thoughts and ideas!

For more work by this artist please visit:

Or contact them at:

Interviewed by:
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Medical school
graduate turned
digital artist, Dr Chee
Ming Wong takes
time out from running
his business, ‘Opus
Artz’, to talk to us
about himself and his
passion for ‘space

medicine’...



DR CHEE MING

WONG

Hello Koshime, could you tell us a bit about
yourself, please? And how would you best
describe your artwork?

Good to meet you, Chris. I'm the Creative
Director and co-founder of a concept and
visualisation company, specialising in pre-
production artwork for the entertainment
industry. | am particularly fond of environmental
and transport concept art, ranging from a

wide genre of aerospace, sci-fi and fantasy,

depending on the client’s requirements.

Could you tell us why you decided to set up
Opus Artz Limited, and where did the name
come from?

Opus Artz came about after having garnered
sufficient critical mass and experience, and
through the desire to provide high quality visuals

for pre-production within a small, tight-knit group

of experienced concept artists and friends. The meaning behind Opus
reflects an “epic work of art”, and is representative of the digital studio that

sets out to produce an exciting diversity of conceptual art and design.

You graduated from Sheffield Medical School in 2001, and then went on to
become a concept artist whilst specialising as an anaesthetist. Could you
tell us why you chose to start doing 2D art when you sound like you had a
very promising medical career?

Whilst specialising as an anaesthetist and early on as a doctor in training,
both the passion to visualise worlds and environments for games and
movies came forth - influenced by the beautiful, lush visuals of various
matte painters and concept artists. It was a time when digital artwork

was coming forth (2001), whereby the use of digital tablets enabled

rapid visualisations of concepts and illustrations that could build upon

the traditional skill-set of industrial design principles. And thus, | built
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upon two careers in parallel over the next eight
years, whilst freelancing on various MMORPG
projects and CGI animation pre-production
projects, whilst being actively involved with

the rapid growth of digital artists. Ultimately
(whilst trying not to quote you a manifesto), the
urge to formalise this experience came forth in
October 2007, with the formation of a European
based team of experienced concept artists and
industrial designers. The aim was to provide
high quality visuals and to concentrate purely
on the pre-production process, whilst providing
a strong design team offering services in
professional web design, packaging and brand

development, all targeted specifically at the
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entertainment industry. Ultimately, | love both
my artistic and medical career. However, with
the recent NHS fiasco, which my training and
job opportunities were significantly impacted

upon, it is perhaps now the time to take a big

risk and to take my fortune into my own hands.

So are your artistic talents self-taught or did you
attend any college/universities?

My schooling in art is entirely self-taught, with
invaluable help, tutelage and critique from the
digital online community. Namely, | owe a large
body of my improvement and art skills to Kim
Taylor, Phil Straub, Don Seegmiller, and the
local Euro/UK ConceptArt.org group. However,
| do sometimes reflect on my progress and
wonder if it would have come to the same
course with a formal background at college/
university. Nevertheless, | learnt my skills
through daily perseverance and through working
on active game projects and freelancing in

illustration and design.
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You have worked on numerous game projects
over the past 7 years. Is this something you see
yourself doing in the future, or is it more of a
side line to your medical career?

Originally this was nurtured as a sideline, but
over the years a transition period, where | see
myself becoming a full-time artist and director
whilst the medical career becomes part-time,

has been fast approaching.

Your interest in aerospace reflects somewhat
in your work. Have you ever attempted to try
different genres, or is this solely where your
interest lies?

Actually, | have various interests in multiple
genres of sci-fi, fantasy and industrial design,
it is just that | have been tasked to draw solely
aerospace and sci-fi related artwork solidly for

the past two years. | have now an opportunity

to branch into various genres, to become a
versatile artist, although aerospace will always
hold a special place in my heart due to the

‘space medicine’ related interest.

So what is it about ‘space medicine’ that
interests you so much?
Some day, someone has to get us up there.

Perhaps | wont be around to personally pioneer



the exploration of the local planets/galaxy, but
any effort to help advance that course, may it be
through a blend of astronomy, medicine and art,
the thought of space exploration can be likened
to the next natural horizon to explore akin to the

Wild West.

What and/or who are your main sources of
inspiration?

Most notably Craig Mullins, John Wallins Liberto
and Erik Tiemens; tempered by the variety of
concept art by various established artists, such

as Feng Zhu, Scott Robertson.

You sound like an incredibly busy man! So when
you have the chance to take time off, what sort
of things do you enjoy doing?

The thought of doing absolutely nothing and

el heelingllong

www.2dartistmag.com page 20 Issue 023 November 2007


http://www.2dartistmag.com
http://www.2dartistmag.com

living domestic bliss with my wife, be it at

home, doing home DIY or slobbing about in the
local community or nature park, is my idea of
having a good time off! This would of course be
interspersed with frenetic drawing, sketching
and painting non-stop, even during my time off,
or on occasion gallivanting to the local museums
or historical sights for sightseeing, sketching and

photography.

Well it has been a pleasure talking with you and
| wish you and your company all the best. One
last question before we wrap things up: what
has been the most influential piece of advice
that you have been given, and by whom?

My father often says that failure is merely a
stepping stone to success. Coupled with sheer
stubbornness and determination, | believe if you

set out to achieve your heart’s desire, the whole
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process of that journey can be sometimes more
rewarding than getting there. In closing, | would
like to say that one should take time to smell the
roses and enjoy the local sights, once you reach

your destination...

Dn. lhee Nlling lWong
For more work by this artist please visit:
http://www.opusartz.com

Or contact them at:
chee@opusartz.com

Interviewed by: Chris Perrins
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Nathaniel West is a freelance
illustrator and designer who works
in both the film and videogame
industry. He graduated in
lllustration before moving into
themed entertainment, where

he worked on theme parks and
museum attractions; his strong
sense of architectural design
now helps him develop the mood
and quality in a variety of digital

environments...

"..allimalely. the nole of
a Produclion Designen is lo
decide how lo visually lell
vision tg the Dineclon... ~



nathaniel

Your background experience in theme parks
and museums is an interesting one. Can you
elaborate on what you mean by connecting
people to spaces “through story, massing,
ornamentation and flow”?

Design influences our everyday world, whether

www.2dartistmag.com page 24 Issue 023 November 2007

some may believe it or not. | have been very
fortunate to be able to come from a background
that is full of real-world spatial design, which has
taught me to think about the viewers of those
spaces and how they will realistically use and
experience them. When you walk into a themed
space, you may not be aware of it, but there

is meticulous planning involved to ensure that
you, as a viewer, will have a specific experience
that the designer wants you to have. There's

a certain style and shape to the architecture,
certain props and décor to tell you a story about
the space, its inhabitants, and how they may
use the space. Ornamentation involves all the

little details that we may easily over look, such
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as the texture on walls, graphics, patterns, hints
of decay, and so on. The way we move through
a space, or how it is introduced to us, is also
key in the overall design. Do we walk through
narrow hallways to get to the space, or do we
walk through an open courtyard first? Does the
space have high ceilings, or low ceilings? Can
we see a glimpse of the space from afar? These
are decisions that will ultimately affect how we

interact with the space and how it makes us feel.

Can you describe with reference to some of your
paintings how you have applied this background
knowledge to help design some of your digital

worlds?

When | design a world, | can’t help but think of
it as a real space that will be used by someone
in some way. I'm always thinking about how it
would feel to walk through that world, and how
one may interact with it. Just looking interesting
is not enough. If it doesn’t work spatially, then
it won’t come across as a believable world.

It is important to think about flow, how one
might walk through the space, and what will be
revealed to them as they turn a corner. It's also
important to think about shapes, and massing
that reinforces the mood of a space. Sharp
angles and forms would be more appropriate
for a sinister space, rather than bubbly circles,

for example. I'm also very concerned with
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props and things that tell a story to the viewer.
| think that telling a story and adding interesting
touches to make a viewer ask questions is what

makes an image intriguing.

One of the images | found intriguing when | first
saw it was the nighttime view of a street lined

with strings of yellow lights [see previous page].

Can you tell us a little about this particular piece
and the idea behind it?

That image is for a film called “Back to
Butterfield”. It's a heartwarming drama set
against the scenic backdrop of rural Texas

and Missouri. At the core of the story is the
emotional journey of an old man named

Norman, who, upon the deaths of those dear to

him, decides to revisit the one place that truly
captured his innocence and his youth, which

is a quaint farming town in Missouri called
Butterfield. Plagued by memories of wrong
choices and missed opportunities, Norman'’s
strong desire to get back to a time when he still
had the world on his shoulders drives him back

to his hometown, despite his failing health.



Following in Norman'’s footsteps is his grandson,
Jonathan, whose same bad decisions have him
repeating his grandfather’s path in life. Their
paths cross on Norman'’s journey to Butterfield,
which happens to be having its 150 year
anniversary festival. This image showcases the
golden and quaint quality that the director and

| initially imagined for the festival in the final

scenes of the film. We wanted a magical quality
in the air, with string lights over the streets and
throughout the trees... almost a timeless quality,
because this town represents timelessness

to Norman. The carousel at the end of the
street plays as a backdrop to one of the most
emotional scenes in the film, and is a reminder

of our youth.

Which particular projects have been the most
interesting from a personal viewpoint, and why?
There have been so many projects that have
been amazing. | have been truly fortunate to
have all the opportunities that | have had come
my way. | would say that right now, the most
interesting and at the same time challenging

projects involve film. I'm currently delving into



production design, where not only do | get to
think about spaces and the characters that
inhabit them, but also about how these spaces
can visually reinforce the emotional tone of
specific scenes, and thus the overall film itself.
Playing with colour schemes and creating

the visual style for a film is a very fascinating
experience, as well. It really opens up a new
level of thought and detail that | enjoy very

much.

The notion of a scene emphasising an emotional
state and using colour as a device sounds very
much like the role of a cinematographer. Do

you ever work in conjunction with these people

behind the scenes and communicate ideas?

| think that is a common notion, but ultimately
the role of a Production Designer is to decide
how to visually tell the story and present that
vision to the Director. That not only includes

the use of colours and styles in the sets and
locations, but also the usage of filters that

go over the lenses, as well. The Director,
Cinematographer, and Production Designer
work very closely together on any project.
Ideally, those three people collaborate on an
equal level, and the exchange of ideas is free
and fluid. The Cinematographer may have great
colour ideas to add to the Production Designer’s
vision, whereas the Production Designer may
have some interesting ideas on how to light a

scene in an exciting way that may further push

Inteniew /ZH/W/]-I/JJI/
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the story. All in all, film is a very collaborative

effort, and it takes many minds to make it a

reality.

It looks as if there are a few photographed
textures in some of your images. Do you use
these to speed up the painting process or
maybe just add a touch of realism?

| would say both. From a production standpoint,
| use different photos and textures to speed up
the process — moving quickly and efficiently.
The most important thing, above all, is to
clearly demonstrate your vision. | am heavily
influenced by certain random photos (it could be
a picture of peeling paint from a wall) and like to

incorporate them into my pieces. | view my work

as a combination of not only digital illustration,
but mixed media collage as well. | draw from
real life as inspiration, and therefore like to make

references to it as a basis for my work.

Which artists do you believe have had the most
influence upon you and who would you site

as the most important within the field of digital
development?

There have been so many people that have
been a great influence to me — it’s hard to
name them all! As far as artists are concerned,
I really love the works of N.C. Wyeth and Dean
Cornwell, simply for their amazing illustration
and storytelling abilities. I'm also a very big

fan of Edward Gorey, John Singer Sargent,
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J.W. Waterhouse, Giorgio de Chirico, Bernd

Haussmann and Syd Mead, amongst others. |
am of course heavily influenced by the master
of digital art himself, Craig Mullins. He has
really opened the door to the possibilities of
digital illustration, but he is rooted in traditional
techniques of the masters before him, such as
the Brandywine artists Howard Pyle, N.C. Wyeth

and Dean Cornwell.

Would you label yourself under the banner of
“concept artist”, or do you see your role being
more specifically related to environmental
design?

| don't think of myself as either one or the other.
| just think of myself as a designer and an
illustrator. I'm very fortunate to have experience
in both the conceptual stages of projects, as well
as how to design them in order to make them
work realistically. So | guess you could say I'm a

little of both.

Could you summarise what you think are

the essential components that are key when
designing a digital environment?

The most essential components when designing

a digital environment are understanding your

story, and understanding the mood you are

trying to create through lighting and atmosphere.

Once you have a full understanding of what
you're trying to portray, anything and everything
can happen. Your environment will undoubtedly
become more detailed in terms of the textures
and the props you will use to reinforce the story

and mood.

When you design environments for video
games, what are the different considerations
that you need to address when compared to
film?

| would say that the differences are very
minimal; the same principles apply to any
situation where you have a character interacting
with a space. You still need to consider spatial
relations, the staging of key elements and story
points. Logistically, you don’t need to consider
construction budgets as much in video games

though, as it will all be built in 3D.

Story seems to be a word that you mention
frequently and attribute much importance to.
Can you refer to one of your paintings and
describe how you have used props and details

to help suggest a storyline to the viewer?

Take the image of the dark Chinese-inspired
alley, for example [see previous page]. The
focus of this scene is the blue alcove on the
right-hand side. There’s a play on traditional
‘old world’ elements with the altar and golden
sculpture above, and the notion that it has
been converted by its ‘modern’ tenants into a
multi-use space with the wiring on the walls,
gas can, appliances, and so on. There is a pile
of oranges on the altar, suggesting an offering,
along with postings on the pillars, which could
suggest that an event of some importance is
occurring that needs announcing. The black
cat subtly suggests an air of danger about the
entire environment, to me. If you were alone on
a street like this and a black cat ran in front of
you, it might give you an eerie feeling. | wanted
to give it a noir feeling... a feeling of danger and

beauty at the same time.

For more work by this artist please visit:
www.nathanielwest.net

Or contact them at:

nathaniel@nathanielwest.net

Interviewed by: Richard Tilbury
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Announcing...

g Mmodo 301

Model by: Phillip Obretenov

Artist-friendly tools that

Image By: Zoltan Korcsokj

elevate modeling into

2

something much more.

modo 301 offers:
Polygon/SubD modeling

Fluid 3D painting
Sculpting
Rendering
Animation

modo has a modern, intuitive user interface and a supportive
worldwide community of artists and designers.

For your Mac and PC

-
. Luxology

Check it out now at:



http://modo3d.click-url.com/EMT/go/mdo0020000072emt/direct/01
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~...1 got to meet Fid NMead
and sal nexd lo him al a Hot

Wheels convenlion, and
we labked for a long lime.
In my mind he has abways

enlentainment design. ~

Dwayne Vance went

from being a designer for
companies such as

Mattel- Hot Wheels and
Troy Lee Designs, to setting
up his new company,
FutureElements. Designing
entertainment vehicles in
2D, to restoring his 1967
Pontiac Bonneville, Dwayne
has a passion for all things

that can be driven! ...



duwiayne
VENGE

Hello Dwayne, well | must start by saying it

was a pleasure meeting you face-to-face at this
year's Siggraph convention! Could you introduce
yourself to our readers and give a little insight
into your progression to where you are today?
You guys do a great job at 2DArtist and it was a

pleasure to meet you guys, as well.

Well my name is Dwayne Vance and | am
married and have three kids. My wife would
probably say | am the fourth kid. Well like most
artist and designers | started at the early age.

| took art classes here and there throughout
school and really didn’t get serious about art
and design until | started college. | started as
a mechanical engineer and found that | wasn’t
a math guy so | changed my major to graphic
design. | had a teacher and my girlfriend now
my wife, really inspire me to apply to Art Center
in Pasadena. So | did and failed then tried
again and got accepted. Finished and got my
degree in Transportation Design in 2000. |

got my first job at a company called Troy Lee
designs, | designed protective motocross gear.
Then moved onto Hot Wheels and designed

lots of toys there. That was a very fun job,

| got to really design what | love, entertainment style vehicles. Then

ended up going back to Troy Lee designs and | designed more protective
equipment. Now | have my own business called FutureElements and we
do anything from product design to entertainment design. | also try to find

time to do Hot Rod art and sell it at shows.

How do you feel the relevance of conferences such as Siggraph and
Adapt have for artists like yourself?

Siggraph is a great show because you get to see what is going on in the
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industry, from 3D software to the movie industry. i
| have not been in a few years and | decided
to go this year at the last minute to make more
contacts. As | am starting my own business |
never know who | will run into at these shows

- like meeting you guys! | also ran into friends
at Siggraph that | had not seen in a while, and
it was very different from when | used to go.
Companies like Lucasarts, Disney and several
others were a lot more open and very friendly.

| got to talk with a few of the guys at Lucas and
asked all kinds of questions about the stuff
they worked on in Transformers. It was very
informative stuff and | could've sat and listen to

it for hours!

Okay, so you're currently starting your own
design company up; could you tell us how that is
going, what sort of work you will be producing?
Yes, the company is called FutureElements and
we will be working on all kinds of projects from
industrial design to Illustration. Things are going
really well right now and | have had to recruit

a few people to help me with all the projects

| have. Some of the current projects | have

been working on are designing stuff for Mattel,

Hot Wheels and Batman properties, as well as
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Hasbro. I've also been creating some mountain
bike designs and lllustration work for Texaco,
and a few other things. Then | have several
projects coming up in the future. | am really
plugged into the extreme sports industry and the
automotive industry, but my next goal is to gain
more work in the entertainment industry. | have
a real passion for gaming and | hope to break

into that industry soon!



i iraynell/ance e

So with your passion for cars and gaming, |
would assume that if you broke into the games
industry you would try and work on a driving
game title. So out of the collection that are
around right now, which one would you most
like to work on?

| know this will sound funny but | really have

no interest in working on a car game. | love
cars and everything about them, but | get really
bored with car games. | would rather work on
something sci-fi like Mass Effect, Halo, Lost
Planet - anything in that type of genre, really. |
have a passion for concept design, and drawing
existing vehicles just doesn't excite me as much.
If I did work on a car game though, | would
choose to work on the Need for Speed games

as they have a little more imagination and

energy to them.

Your passion for automotive design started way
back when you were a child and has played a
huge part in your professional career through
your work for the likes of Hot Wheels and
Mazda, as well as in your personal life through
the restoration of your 1967 Pontiac Bonneville!
Could you tell us how this passion came about?
Right from when | was a little kid it seemed

like it was in my blood. | was always drawing
exotic cars like Ferraris, Lamborghinis and so
on. Then | tried to draw cars and combine them
to see what they would look like! Most of them

were hideous, but then | was trying to design

them back when | was about nine! Then | saw

www.2dartistmag.com page 37 Issue 023 November 2007


http://www.2dartistmag.com
http://www.2dartistmag.com

an Art Center catalogue when | was in JR High
and decided that was what | wanted to do: draw
things for a living. My dad and | restored a 1967
Mustang together when | was in high school,

so this only fed my passion for cars. Then later
on in my career | got a job at Hot Wheels and it
was the best fit for me because it was a mixture
of entertainment meets automobile. And yes, my
1967 Pontiac Bonneville is my current project,
just because | needed a cool car to work on! As
a designer | am adding my own flare to it, as
well. | still have a huge passion for Hot Rods
and Muscle cars so | do artwork based on

that genre of stuff. Then | also run and own a

website called www.



Did you ever consider forging a career
in creating concepts for big named car

manufactures?



If you could sum up your style of art work into one sentence, what would
it be?
Good question! My slogan for my company is “high energy art and

design”, so I'd like to try to stick to that.

Throughout an artist’s career, they will always look at artwork by there
favourite artists, whether for research or inspiration. So which do you find
your inspiration from?

Oh wow! Yeah, | have looked up to several people out there and there are
so many good names to choose from. | can tell you that whilst | was at
Hot Wheels | got to meet Syd Mead and sat next to him at a Hot Wheels
convention, and we talked for a long time. In my mind he has always been
the Godfather of entertainment design. So at an early age | saw his work
and always loved it. Other names that come to mind that have influenced

me are Scott Robertson, who | had as a teacher and he really pushed

e waynel/ance.
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and inspired me; Craig Mullins, Ryan church, Mark Gorner, Sparth, Vyle
and all the guys from Steambot. Those are probably my top picks! | am
constantly looking at people’s work for two reasons: one, because they

are my competition; two, to be inspired and to push myself harder.

You mentioned you met Syd Mead whilst at Hot Wheels. If you could work
together on a project in the future, what would it be?

Wow, another big question! Well, Syd Mead is known for his sci-fi stuff, so
| guess some sci-fi game or movie. Maybe if someone wanted to expand
the story of Blade Runner and do a hew movie based on the original that
would be awesome, since Syd is so well-known for that movie. | would
also love to expand the story of my Arc Mechs; | really like the story that
goes a long with it and | think it would really lend itself to some great

visuals. So it would be really be cool to see Syd’s take on it!
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Well it has been a pleasure talking with you,
and | wish you all the best in the future with your
company. | have one last question before we
wrap things up, though! Over the course of your
art career, what has been the most influential
piece of advice that you have been give, and by

whom?

Duwayne Vance
http://www.futureelements.net

dwayne@futureelements.net

Chris Perrins


http://www.futureelements.net
mailto:dwayne@futureelements.net
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Tlgi Inthavot¥

Noi Inthavong is a graphic artist with a variety
of skills, ranging from print to web design and
3D animation on both Mac and PC platforms.
Noi told us, “Throughout my experience in the
various fields, | have come to realise what kind
of career that | am most passionate about -
is concept art. | love the feel of the stroke of a
paint brush. | know the importance of concept
art because it is the first step where ideas are

visualised”.



Beale was a character concept

that | drew for Falling Door
Production. | had to look
through many different kinds

of amphibians and lizards in
order to come up with him. He
was supposed to be one of the
inventors’ assistants, hence the

apron and spectacles.

The Llowns

The clown pictures were a few
of the concepts that | did for a
friend. It took me three tries to
get the right sized one (the
smallest). After | was done

| realised that they would
make a really interesting
staged sequence, so | put
them together.

| started off with a 0.5
mechanical pencil and

then went over them with

an ebony pencil. | then
scanned them into Photoshop
where | put them together and

cleaned them up.
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The ninja concept was drawn up to have a friend of mine model him in

3D. He was mainly inspired by the SNK'’s version of Hanzo Hatori, from
Samurai Showdown. | wasn't really going for a typical Japanese Shinobi;
instead | was going for more of a fantasy version. So | mixed him up a little
with a Western designed armour.

This one was finished with an ebony pencil and was scanned into

Photoshop for final touch-ups and some cleaning.

Rayne

Rayne was another one of the characters that | designed for Falling Door
Production. At the time when | was designing her, | was really into Hyung

Tae Kim’'s work from Magnacarta, hence the different ornaments and
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braided designs. She is also one of my fantasy

shinobi characters.

Risa

In this concept, | was trying to create a fantasy
insect girl. | gave her a small belly in order

to make her resemble more of a young girl. |
had to research through many different insect

pictures in order to come up with her.

HRonnelle

Ronnelle was also a character | designed

for Falling Door. She was designed to be a
beautiful yet lethal warrior. Her clothing styles
were meant to be decorative with lots of jewels,
whilst still allowing her to be very mobile. The
ornamental dress and hair piece were design to
be used as an unnoticeable weapon. With this
piece, | went through many different ideas and

designs before the team found the right outfit.

For more information please visit:
www.3thumbsup.Ocatch.com

Or contact:

noiinthavong@hotmail.com
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http://www.thegnomonworkshop.com

Fallon, B-Reel and nine artists from
around the world collaborated to
create a mesmerising mini-site for
Sci-fi Channel’s new mini-series,
“Tin Man”, inspired by the ZoomQuilt

project...

7 bove this staflf. 1 s motion
code * navrative  inlenaclivily
* beauly. H5 the kind of
ewpenience | wanled back when
1 finsl jumped online in1995.
s a geek s panadise bal it s
can enyoy.
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infinite 0z

Tin Man

Infinite OL “Tin Man"~

Fallon, B-Reel and nine artists from around the

world collaborated to create a mesmerising mini-

site for Sci Fi's new mini-series, “Tin Man”.

Inspired by the ZoomQuiilt project, the

Infinite OZ site beautifully captures the inter-
dimensional weirdness of the Outer Zone ("OZ")
by surrealistically embedding one dreamlike

vista in another.

What makes the project tick, though, is the
injection of thoughtful motion and excellent
sound design. Atmospherics like rainfall
and particle fields are buttressed by shifts

in the sonic landscape, adding depth to the
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fantastically detailed paintings. The whole
experience is seamless, thanks in large part to
some bad-ass code running under the hood,
but also thanks to the natural way in which each
artist's painting resonates with those before and

after it.

I love this stuff. It's motion + code + narrative +
interactivity + beauty. It's the kind of experience
| wanted back when | first jumped online in
1996. It's a geek’s paradise—nbut it's also the

kind of thing my mom can enjoy.

belling Back lo Pangea

Over the last several years, the fields of motion
design and interactive design have been
overlapping more and more. The overlap has
been driven by a combination of technological
advances and a paradigm shift on the part of
designers to regard the web as a broadcast
medium. Some people—dubbed “visionaries”
in the 90s because their creativity outpaced
the available technology—have seen this trend
developing for a long time. But the ad dollars
and broadband penetration simply weren’t

there to justify their grand ideas. Now things
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have changed. The big money is going to the
web. Budgets for web sites can be staggeringly
huge—much larger in many cases than the
budgets for national television spots. With these
burgeoning budgets has come some willingness
to experiment. If you don’t believe me, hop on
over to The FWA and launch the first few sites.

There’s some truly ballsy stuff going on there.

Eeodus, Movement of The
People

I've met a lot of interactive designers who've
migrated to motion design. I'm one of them,

in fact. | couldn’t wait to leave behind the
comparatively limited capabilities of Flash for
the seemingly unlimited power of After Effects.
When | threw Cinema 4D into the mix, | started

to feel like a god.

But all that time Flash was growing up,
becoming much more sophisticated than a mere
vector animation tool. ActionScript hit puberty
and then went dashing into adulthood, becoming

a fully fledged object-oriented language.

Meanwhile, the authoring environment sprouted
all sorts of interesting new tools. Perhaps the
most relevant evolution for motion designers,
however, was the way in which Flash’s video
support changed over the years. Initially, the
Flash Player’s video functionality was simply
seen as an alternative to QuickTime and
RealPlayer. It was just another video player,
albeit one with greater penetration by far than

the alternatives.

As the video codecs improved, two things
happened. 1) High-quality video with low data
rates was possible. 2) Alpha channel support
was introduced. That, combined with overall
performance boosts in the Flash player,
particularly with regards to handling bitmap
data, set the stage for the quiet revolution taking

place now.

| find it a little strange that so many interactive
designers have come knocking on the door

of motion design but that the reverse is

seldom true. | think this will change. As motion
designers begin to see how much fun it is to
build projects for the web and as the underlying

technologies continue to evolve, | think we'll see


http://thefwa.com/

more and more motion freelancers being picked
up by studios like B-Reel. To put it another way,
studios like B-Reel, who put web and broadcast
on equal footing, will start snowballing into larger

and larger powerhouses.

For now, add some interactivity to your daily
diet, if you haven't already. Think about how
motion might become more than just a passive
experience. Consider that you have the power

to create entire worlds, not just 30-second spots.

Article Written by and Courtesy of:

Justin Lone
Editor, Motionographer

For more information, please visit:

http://motionographer.com

B-Keel and Jallon Promote
FciAfi Mini-Senies, TN
U, Witk Infinite 0L
Websile

The “Infinite OZ” site allows visitors to
experience the world of the Outer Zone — www.

road2o0z.com.

B-Reel is proud of the new collaboration with
Fallon Worldwide. Together with Fallon’s media
department and the creative team, then headed
by Calle Sjonell and Pelle Sjonell, B-Reel
directed and produced a promotional micro site
for the mini-series Tin Man, to be aired on SCI
FI Channel on December 2. Fallon’s media
department and B-Reel set out to create a flash-
based digital experience to evoke interest and
create a buzz around Tin Man, the re-imagining
of the literary classic The Wonderful Wizard

of OZ. B-Reel also produced HD broadcast
versions for television, cinema and in-store
media. The inspiration came from the art
project of the ZoomQuilt, originally created by
designers looping Flash scenes together, letting
the viewer experience a seamless journey from
scene to scene. This was the start of B-Reel’'s
collaboration with nine of the most talented

CGl artists in the world: Phil McDarby, Gerardo
De Gerard, Rudolf Herczog, Raphael Lacoste,
Martin Lisec, Greg Petchkovsky, Andreas
Rocha, Philip Straub and Geoffrey White. The

zoom incorporates 15 different key scenes from
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the mini-series. While the artists were allowed to
freely interpret their assigned scenes, they were
given general technical and graphical guidelines
as well as specific briefs. This allowed for
smooth transitions between the scenes and the
creation of freestanding elements suitable for
animation and that could be adjusted for both
web and HD broadcast versions. In order to
achieve a never-ending zoom and maintain full
resolution, the artists created their scenes in
10k resolution. Once the scenes were delivered,
the B-Reel crew began their work linking

them together and bringing them to life using
animation, weather and light effects. In order to
process this much graphical data, it was crucial
to use the latest version of Flash, version 9,
combined with the latest Action Scripttm 3.0
programming language featuring improved

performance and increased flexibility.

lboal...

B-Reel, is a hybrid production company that
directs and produces live action, animation and
interactive. The productions seamlessly traverse
media platforms, from television to the web. The
company has offices in Stockholm and New
York. For more information about B-Reel, please

visit www.b-reel.com

Contact: Niklas Lindstrém, Executive Producer
Phone: +1 212 446 6765
Mobile: +1 917 455 0398

Email: niklas.lindstrom@b-reel.com

Fallon Worldwide, one of the world’s most
critically acclaimed, creatively driven branding
companies, manages the consumer voice of
some of the world’s leading brands, including
Sony, Nestlé Purina, TIME Magazine, Holiday
Inn, Holiday Inn Express, ASDA, National Car
Rental and Alamo Rent A Car, and Orange.
Fallon Worldwide is a global network of
Publicis Groupe, based in Paris, and has 500

employees worldwide. The company has offices

in Minneapolis, London, Singapore, S&o Paulo,
and Tokyo. Additional information can be found

at www.fallon.com

SCI FI Channel is a television network

where “what if” is what's on. SCI FI fuels the
imagination of viewers with original series

and events, blockbuster movies, and classic
science fiction and fantasy programming, as
well as a dynamic web site (www.scifi.com) and
magazine. Launched in 1992, and currently in
92 million homes, SCI FI Channel is a network
of NBC Universal, one of the world’s leading

media and entertainment companies.
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W someone finds oul how
lo un-glue MM

This month, we’ve asked 2D artists from a variety of

backgrounds and locations around the world:

How di you lake lime oul
prom the wonld of (5 7 (hl?

Here’s what they said...



Time Oul

llndnew Hou

Senior Concept Artist, Webzen

Seoul, South Korea

“If someone finds out how to un-glue themselves
from their magical chair, please send me

an email! The shape of my bottom is slowly

morphing anatomically into a different shape...”

Freelance lllustrator, Berlin, Germany

“The usual stuff: gym, movies, computer games,

parties. Not necessarily in that order.”

[hnislophe Vachen

Concept Artist, Painter & Art Director,
Luxembourg & Los Angeles, USA

“| always make time for myself outside of

the CG/Art world. It's a matter of mental and
physical health. My second world is the world of
martial arts. I've been training in all sorts for 25

years now, but that’s another story.”

Graphic Designer & lllustrator, Mobil
Entertainment Company, Berlin, Germany
“Meet with friends, my boyfriend, or simply

watch TV.”

Daniele Bigi

Lead Lighter & Compositor, Aardman
Animation, Bristol, UK

“For most of the people who work in an artistic
world, work is often an obsession and it is really
hard to be able to take time off. The only way to
relax is to go on holidays, but often when | am
away | see something interesting and | start to

think about a new project!”

Uon Secgmillen

Freelance Concept Artist, lllustrator & Artist,
Utah, USA

“I fly fish and ride my motorcycle.”

&gil Paulsen
“More studying.”
Srich Ichreinen

Freelance Artist, Germany

“l am visiting the gym three times a week, and
meet with some friends at the weekend, etc. |
also try to watch interesting films at the movies
or DVDs for inspiration, etc. In fact, when you
try to make a living out of something it's nearly
impossible to take time out, because you always

think about it... and | mean always!”

Graphic Artist, KICK Design, New York City
“Oh there are plenty of things in this world

to distract me from art... too many in fact:

music, cooking, reading, travelling, and just

spending time with interesting people and good
conversation. Art is an important part of my
life... but it's only one part. Having an open mind
and experiencing the world around us is even
more important than that next art project sitting

on my desk.”

Kenem Beyil

Concept Artist & lllustrator, Aranim Media
Factory, Turkey

“Well, | do what most of the guys do; reading
comics, books, watching movies (mostly CG

movies), hanging out with friends...”

Freelance Concept Artist & lllustrator,
Colonia, NJ, USA

“Getting outside and enjoying nature, scenery
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and getting some sun. It's not healthy to sit in
front of a computer twelve hours a day - it's
detrimental to your eyes and your hands. |
like to play games, watch movies, and visit
family - basically anything to take my mind off
the computer screen sitting at home. | draw
practically every day so getting away from

art in general is impossible, but drawing in
my sketchbook is a break from staring at the

computer, so it’s relaxation for me.”

Environment Artist, Recoil Games,
Helsinki, Finland
“I go walking with my dog, eat out in a good

restaurant, or go see an interesting movie.”

Ul & Concept Artist, High Voltage Software,

Hoffman Estates, IL, USA

“When I'm not producing artwork? Well, |

image by Daniela Uhlig

generally find myself gaming with friends or
dancing at the city night clubs. | prefer to be
as active as | can be and surround myself with
social interaction when I'm not plastered infront

of my computer screen!”

Daul Whight

“It's not much of a change, but digital
photography at the moment. That combined with

some good country air!”

Raluca losiffesca

“Actually it's the other way around: | take time
off from my job for CG graphics, and | don’t
intend to put it into second place. | need drawing

to be happy!”

Robert Lhang

“CG/Art isn’'t the biggest thing in my life,
anyway. | might do it as a job often, but when
I'm not working | tend to spend my time
shooting photography, composing music, writing
screenplays and novels, watching movies,

reading books, playing video games and so on.”

Concept Artist, Cryptic Studios,

Los Gatos, California, USA

“I'll watch a movie sometimes or go to hang
out at the book store. But honestly, I'm always
thinking about what would be cool to paint or

design next.”

“l am 22 and my busy life goes at around
hundred kilometres an hour! | haven't other
artistic activities, but | work in a psychiatric

hospital as a psychologist.”

oy lein

“l love watching movies - it gives me energy and

muse at the same time.”

lllustrator & Designer, Bandai Namco

Games, Tokyo, Japan

“| play with Kotaro, my dog.”
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image by Daniele Bigi

dam Lamont

2D Animation Student, Glamorgan University, Trefforest, Wales, UK
“Mainly socialising and computer games, | suppose. | love the alternate
realities that games present you with, where you can escape for a short
time and be immersed in someone else’s worlds and imaginings. But |
also write alot; mainly my own fictions based in a world which | have been
developing for a long time, and this helps me to focus on something else

for a while.”

Jasha Podogrny

Designer, http://tiro.by, Belorus, Minsk
“Does it happen? | draw and paint from life. | like watching movies, such

as Tarkovskij’'s ‘Andrej Rublev’.”

dimon Legrnand
“I take time out from 3D with 2D! But my beautiful girlfriend is probably my

best “breath of fresh air”. Going to the gym regularly is also a great way for

me to switch off.”

Tim lWannock

Senior Matte Painter, Intelligent Creatures, Toronto Ontario, Canada
“Three months ago | would have said that | don't really. | have the
tendency to live a bit of an unbalanced life, but my wife and | had our first
child in October and | have had to make a few adjustments. | really love
my work so it is hard to set it aside, but when | do these days it usually
involves hanging out with my family, watching movies and changing my

son, Liam’s diapers.”

Tuna Jenid

“Art is my job and | am an Art educator, so it's very hard for me to be
outside of art in my daily life. However, in the short times that | don’t

work on art, | have an interest in making research about geography and

image by Don Seegmille
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image by Mikko Kinnunen

world history topics. Computers have been an

important part of my life since childhood. When
| was a kid, | had a Commodore 64. After that,
| bought an Amiga. I'm still playing old games!

| like some of the new PC games, such as
“Starcraft”, “Heroes of Might and Magic” and
“Half-Life” - they are my favourite games. If |
find time, | also play strategic games during my

weekends.”

Vinegan

Freelance Artist, Warsaw, Poland

“Just like everybody else resting from work,

| guess; meeting people, taking a walk...
although it's hard to say | get separated from it
as everything can be, and is, an inspiration, so
if you're any kind of creator then ideas are just

coming from everywhere!”

Vilaly 8. Mlerins

do photography from time to time, but that's also
art. Art is what I live on, breathe on and draw on.

Sometimes | eat...”

Y. donern Yurlseven

“| follow other artists’ artworks, watch animated
films and talk about them with my fiancee. We

also create new concepts and projects together.

| love to be with our cats and dove. | like doing

things which are both fun and improve my

creativity.”

(oming nexl month: we ask
anlisls.

oo

Freelance lllustrator, Toronto, Ontario, Canada

“You don'’t take time out of art, you put time in! |
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Qdventunes of Rabbit
Teng Lin
www.tianruidm.com

linteng1981@hotmail.com
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10 0f the Best /jﬁg{Wbﬂt/)

Kerem Beyit
www.kerembeyit.deviantart.com/

kerembeyit@hotmail.com

The lvialon

Bruno Werneck
www.brunowerneck.com

contact@brunowerneck.com

You can follow an in-depth interview with this

artist in the October issue of 2DArtist Magazine!
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Copyright © Moonstone Books

Kieran Yanner

www.kieranyanner.com

Kieran@KieranYanner.com



http://www.kieranyanner.com
mailto:Kieran@KieranYanner.com

oo reced/ e {?Wfb,vms

Visiling Nllothen-in-law
Denis Zilber

www.deniszilber.com/

mail@deniszilber.com

Tom (hihun Opasinshi

Tom Arthur Opasinski

www.tom-arthur-opasinski.com

www@tom-arthur-opasinski.com
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Tiberius Viris

suirebit@kingofhouston.com
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Image Title

Benita Winckler Artist Name
Www.eeanee.com Website Address
benita@eeanee.com eMail Address
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we Treasure
a Good Eye.

Vancouver Film School knows Animation.

We offer one year programs for artists in Classical
Animation, Digital Character Animation, and 3D
Animation and Visual Effects. For the pro who
wants a real advantage, VFS also offers 6-month
Houdini™ Certification.

Pixar. Rhythm & Hues. Industrial Light & Magic.
Ring any bells? Every year our graduates start
careers at the world’s elite production studios.
They've worked on Pirates of the Caribbean,
Transformers, Shrek the Third, you name it.

Vancouver Film School is now accepting
applications for our January 2008 start date.

VFS Student work by Michael Lewicki

= ANIMATION
>

vfs.com/animationvfx


http://www.vfs.com/animationvfx
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Styised/AnimalChallence 7{’77' 7/

Stylisecl Animal Ciallenge

Hyena

Ihe lhallenge

Welcome to the Stylised Animal Monthly Challenge. Each month, we will
select an animal and post some images in the forum thread as reference.
All you have to do is to create a 2D image of this creature in a stylised/
abstract/cartoon style, whilst keeping your creature instantly recognisable.
We wanted to publish some content in 2DArtist Magazine on how to
create stylised animals, such as you see in the many feature films and
cartoon galleries. We thought this regular competition might bring in just
the images and Making Ofs that we need, whilst giving away great prizes
and exposure. If it continues in success, we will try to boost the prizes as
much as possible! This month’s animal was the Hyena. Here you can see

the top nine entries, as voted for by the public...

sth MIl'lI ”"b avivor@gmail.com sth [amm
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7th Péler Temesi, aka W# hopsy@t-online.hu
UWhal are we looking fon?

Funny and humorous entries which break the animal down to its most
recognisable components; emphasise these in whichever ways you think
best, and render your stylised/abstract/cartoon masterpiece. The rules are
pretty laid back: please submit 1 x 2D render (minor post work is OK); it's
up to you if you want to have a background or include graphical elements
or text on your image. Renders of the 800 pixel dimension sound about
right, but the winners will be featured in 2DArtist Magazine, so if you can
create some higher resolution images, too - all the better! There will be
one competition per month, with the deadline being the end of the month
(GMT). For a valid entry, just make sure your final image is posted in the
main competition thread before the deadline. We require the top 3 winners

to submit Making Of overview articles that will be shown on either 3DTotal

sth Nai Ichilllen

13Lord@web.de
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ylﬁ,paye[wa& davejneale@hotmail.com 3[;4%5”% jakegumbleton@hotmail.com

or in 2DArtist magazine. These need to show the stages of your creation,
different elements and some brief explanation text of why, and how, you
did what you did. We will format this into some nice-looking pages to give
you some great exposure, and us some quality content! Each competition
will have one main thread which starts with the brief at the top. All entrants
should post all WIPs, give feedback and generally laugh at the crazy ideas

that are emerging each month...

The entire Mcompetition can be viewed here.

The current challenge at the voting stage is:

Dinosaun: Hernbivone

The current challenge taking place is:
Dinosaan: Lannivone

To join the next challenge, or to view previous and/or current entries,
please visit: www.conceptart.org

Or, for the 3D Challenge, please visit: www.threedy.com

Or contact: lynette@zoopublishing.com

zndfuan laruso

juan_carusoart@yahoo.com
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ul]malan 7(1%68[1«'&& jonatan.ie@gmail.com
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30 lhallenge

Here are this month’s top three winning entries from the 3D competition...

ZMM zinkete@gmail.com

jnd%m huielbashir@gmail.com

alexandre_aillet@hotmail.com
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Here are the Making Of from last month'’s top 3

winning entries...

znd - Juan Lanuso
J’Iep 1:

First of all | did some pencil sketches and
selected the one which worked best for me, or

at least made me smile the most (Fig01), and

scanned it in at 200 dpi. Always try to have Fig.01

fun with the ideation and leave the mental

frustrations behind.

Crocs have a lack of athletic movements, for
example they can't jump, and so out of context

ideas can give a new personality to this animal.

In a new Multiply layer filled in white, with the
Opacity at 40% over the pencil sketch, | traced
the line art with a brush (Fig02). | deleted the
pencil layer and established a white-filled

background.

J’Iepz:

In a new layer added | flattened the colours with
a semi-smudge shaped brush, not worrying too
much about the edges. With an irregular shaped
brush | then added some texture for the skin
(Fig03); with the SSS (semi-smudge shaped)

brush, following the direction of the body, |

added the form of the belly and shadows. At this

point | started to make some decisions on the

background colour. Fig.02
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Stylsed’AnimalChallende wena

Time to add some props: a hat, some teeth and
an eye - only in the base colour. The tie works
like an accent (Fig04). | added some bright
areas to the belly with the SSS brush. Using the
same brush | also added the shadowed areas
for the props (Fig05) and some highlights to the

eye and the cigar.

Ilep -
For the smoke from the cigar | used the SSS

brush and a low opacity eraser with the SSS

configuration (Fig06a). For the background |

used 2 brushes (Fig06b) to add the effect of a

Fig.05
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yena syisedAnimalChalence

“messy shrub”. To make the croc stand out, |
added a white contour line. | wasn't happy with
the colours’ tonalities, so with the Color Balance
option | changed the background and the croc in

order to a warm up the composition.

Fig.06b

Fig.06a

Juan Lanwso

Contact them at:

juan_carusoart@yahoo.com
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| started out by sketching the main masses of
my little fella very quickly, making sure his pose,
attitude and features were more or less what |
was after - cute, non-threatening and lovable

(Figo1).

3’Iepfz:

On a new layer | drew the croc again - a
little tighter in design and a bit cleaner in
appearance. Based on my initial sketch, |

achieved a clearer vision of what it was | was

trying to convey with this crocodile dude (Fig02).

' 77/
StyisedAnimalChalengei/ 24424

Fig.01

Fig.02

Fig.04

Fig.03

3@3:

| filled the croc silhouette shape with a dark
green on a new Multiply layer, and painted in
a lighter green to imply a general light source.
With a custom brush, | created a patterned
texture on the little guy’s back, legs, arms, tail

and head (Fig03).

J@, L2

Here | started painting in the rough flats of the
croc’s features. Refining the shapes,

| painted in the belly parts, more head detalils,
the teeth, tongue and eyeballs. The under
painting of greens pops out in certain areas,
creating more depth and light and shade for the

curves (Fig04).
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JkﬁvS:

| kept painting in more details as | went along,

pushing the forms and light and shade. Using
more custom brushes | created more texture
work. | added the small bumps on the back and
tail, and painted in more details for the face,
mouth and tongue. | used a hard brush to paint
in the flat background colour to frame a cleaner
look for my main figure. At this point | noticed
that the far side of the mouth looked a bit off,
and so | fixed this by painting that part further
into the flat background colour, where the cheek

used to be (Fig05).

Jkﬁvﬂ:
With a custom made brush | gave the

background a nice texture so it didn’t look

too dull, and so it would somewhat speak the

Fig.05

same language of the croc’s texture. | added a
shadow cast by the crocodile, and with a Blur
filter | gave the little buddy'’s tail some life of its

own (Fig06).

dinal Touches

Here | just added in more detail work on the
background and shadow, the croc’s mouth,
and added some nice drool on his tongue. On
a new Color layer | filled in a cool purple colour
and lowered the opacity of that layer. This
gave the overall colour scheme a more unified
appearance and softened the harshness of

the greens a little. As a final touch of humour

| painted in a little bee hovering above, which
shows some playfulness in the croc’s character
and gave the guy something to look at, with

those googly eyes of his (Fig07).
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Palni Balanovshy

http://chuckmate.blogspot.com

Pat2005b@hotmail.com

Fig.07
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18¢ - Daveneale
Inbroduction:

Well this was fun all-round, and joint first is very

cool! I learnt a lot from this one, and had a lot of

fun with it, too.

The Making Of:
After finding a bunch of images of crocs on
Google, | got going with the picture. I've always
loved the above/below water thing; whether it be
cool photos of tropical coral or a cool fish tank
set up at the zoo - | just love the juxtaposition of
the two worlds, side by side. | wanted to capture
this in the image, but other than that there was

no planning (Fig01).

To start off with, | decided on the colours |
wanted to use and got to messing about with

some kind of background. | was mainly just
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playing with some custom brushes at this point
and trying to keep the colour scheme something
that | liked (Fig02).

| then continued to add the background
elements, but also roughed in the croc - no
planning with it though, | just went with the flow
of the background and went for a pose that |
thought was cool. | knew that | wanted to have
the eye as the main focus along with only very
different hues in this image, so | used this as a

starting point (Fig03).

My choices of brushes in this image were
central to the success of the image; rather than
trying to make brushes | already had work in
the image, | made the brushes for the image. |
basically studied the reference | was using and
came up with some brushes that would produce
similar shapes when applied to those that | saw
in the photographs. It was an interesting thing to

do, and | think it turned out pretty well (Fig04).

. 77/
Styised/AnimalChallenoe/ Z4E

/
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| have taken to flipping my canvas whilst
working on an image; it's something I've picked
up from other tutorials and demos that I've
seen, and it really helps me get a fresh eye on
the piece I'm working on, as often | find myself
totally immersed in a picture which can mean
that stuff I'd notice right away in someone
else’s work (wonky perspectives or misplaced

elements) totally eludes me (Fig05).

| just kept working on the image here; there’s no
real secret, | was just using my custom brushes
and the Photoshop standard hard round brush
(with opacity set to Pen Pressure) to work out
details, add some highlights and add the water

(Fig06).

| then went on to add the final touches; adding

some reflections from the water, putting the

roots of a mangrove in the background, and also
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David lleale

davejneale@hotmail.com
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Custom Brushes

Mike Lim, aka
Daarken, talks you
through this Custom
Brushes tutorial,
explaining how to
create your own
brushes and how they
can be applied to your

own artworks...



Custom
Brusnes

Fig01

luslom Brashes Revisiled
by Daanken

In the past | created a custom brush tutorial

in which | showed you how to make your own
brushes. | figured | would start out again by
showing these steps since some people may
have not seen the other tutorial. After that | will

show a few brushes that | like using, as well as

how to create some effects using these brushes.

These brushes are included at the end of the
tutorial, so you can download them and follow

along.

Most of the time | use only a few brushes, but
some occasions call for me to make a specific
brush (like the chain mail brush). Sometimes

I will create a brush that | will continue to use
throughout my career, but most of the time |
will make a specific brush to handle one type of
effect for a specific illustration that | am working

on.

Fig02

Fig03

Let’s start out by making a brush. | want to
make a brush that | can use to add texture to
my illustration, like some scratches on metal or
texture on bricks (Fig01). | start out by making
some random marks on a blank canvas. Try not

to make the pattern repeat too much, but it isn’t

that big of a deal since we can fix that later on
with the brush controls. After you are happy with
what you have, go to Edit > Define Brush Preset
(Fig02). This will capture the image as a brush.
Make sure you have the brush tool selected

(short-cut key, B) and then right-click on the
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canvas. A window will pop up with your brushes
(Fig03). The brush you just created will be at
the end of that list. Now that you have created

the brush you can begin to plan with the brush

controls.

Click on Shape Dynamics (Fig04). This is where
you can alter the shape controls of the brush,
such as Size Jitter and Angle. By using these
features you can make your brush look more
natural and not like a repeated pattern. The next
option | select is Scattering (Fig05). Here you
can kind of “pull” the brush apart, or scatter it,
so that you don’t have to paint with a single row

of paint. I also click on Other Dynamics and set

Fig04

Fig05

the Opacity to Pen Pressure. The brush is pretty
much done and ready to go now (Fig06 - 07).

In order to save the changes you have just
made to the brush, right-click on the canvas.
The brush dialogue box will pop up. Click on the
little paper icon in the upper right hand corner of
the window. This will save your brush and stick

it at the bottom of the brush list.

In this example (Fig08), | used the brush to add
some texture to the metal of the armour, as can
be seen. The next brush | want to talk about is
a brush that | got from someone at work. This
brush was made specifically for painting clouds.
This brush is great. It makes painting clouds
very easy and you can get a fairly good result

very quickly.

Fig06

" -

Fig07
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| start out by making some strokes with the
brush (Fig09), trying to add both small and

large shapes. Next | add some shadowed areas
beneath the clouds and begin to refine more

of the shapes (Fig10 - 12). After only a few
seconds | have a decent representation of some

clouds.

Before | wrap up the tutorial, | just wanted so

show a few brushes that | use fairly often...

Fig09

Fig10

Fig08

Fig11

Fig12

The first brush is also pretty good at making
clouds, as well as smoke. | also use this brush

to lay in background textures (Figl13).

This brush is one of the brushes that | use the
most. The main function | use this brush for is to
lay down the basic shapes of armour. Since this
brush already has a lot of texture it is a good

starting point for painting metal (Fig14).

| think this brush is actually just a Photoshop
default brush, but all of my illustrations are done
with this brush! | like it because it has a little bit
of a natural brush feel to it, and at the same time
you can still get sharp lines. It is also very good
for painting the different planes of an object.

(Fig15).

This next brush is something that | made a long
time ago for painting backgrounds. | think |
made this brush from a photograph that | found

of a water wave (Figl6).
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This is a brush that | found on the Internet. | like
to use this brush for painting hair. It has some
random qualities because the Angle Jitter (under
Shape Dynamics) is set to Pen Pressure, which
helps to achieve some of that randomness that's
found in hair (Figl17). (Note: this brush is not

available as a download with this tutorial.)

As you can see, creating custom brushes is
quick and easy and can add a lot of character
to your illustration, but always learn how to paint
textures without having to rely on a special

brush. Try learning how to paint clouds by

just using a normal round brush, or painting Fig13
scratches in metal, or smoke. Custom brushes
are just a tool, not a replacement for the
fundamentals that every artist should learn.
For more from this artist visit:
www.daarken.com
Or contact:
daarkenart@daarken.com .
Fig14
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SynthEyes 2007 ®

3-D Camera Tracking Software

Now with

G STABILZATION

Maybe you are shooting hand-held, and need a more professional look. Maybe you are using other stabili-
zation software, but are tired of limited functionality, poor tracking, or strange geometric distortions in the
results. We've got the cure!

SynthEyes now includes an awesome image stabilizing system, based on SynthEyes’s famously fast and
accurate tracking. Integrating auto-tracking and stabilization makes for a terrifically fast workflow, and
means we can do all the sophisticated things to produce the highest-quality images possible. We added
the flexibility to nail shots in place, but also to stabilize traveling shots. Then, piled on a full set of controls
so you can direct the stabilization: to change shot framing, add life, or minimize the impact of big bumps
in the footage. Since you've got other things to do, we multi-threaded it for outstanding performance on
modern multi-core processors.

We didn’t forget about pure camera tracking either. SynthEyes 2007%2 adds single-frame alignment for
nodal tripod and lock-off shots; a way to add many accurate trackers after an initial solve, for mesh build-
ing; a way to coalesce co-located trackers, perfect for green-screen tracking; and about 50 other things.

One thing we didn’t change—our incredible price:

"l used SynthEyes exclusively while working on Pan's
Labyrinth, and the CG Supervisor was continually amazed
at how | was blowing their deadlines clean out of the water.

| used the zero-weight points to model many surfaces
which needed to be very accurate, so that a 3-D stick bug
could walk across them.”— Scott Krehbiel

“2D at FUEL used SynthEyes for a few especially gnarly
shots during Charlotte's Web. For $399 and a couple of
hours invested in the docs, our compositors can solve a

camera for almost any shot. SynthEyes is smoking fast,
easy to understand and the support is phenomenal.”
— Sam Cole, FUEL

Other recent credits: Apocalypto, Bridge to
Terabithia, Casino Royale, Deja Vu, Next,
Pirates of the Caribbean: Dead Man’s Chest,
Pursuit of Happyness, Spiderman 3, Zodiac

See the website for more details on ANDERSSON TECHNOLOGIES LLC

SynthEyes'’s amazing feature list. For more information and free demo:
http://www.ssontech.com

Fourth year in the market,
PC/PC 64-Bit/Intel Mac/PowerPC Mac serving VFX artists in over 40 countries

25+ Exporters included standard.
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Welcome to the Speed Painting section
of the magazine. We've asked not two,
but three artists this month to produce
a speed painting based on a simple,
one-line brief. Here we feature the

final paintings and the overview of the

creation processes.

This month, Mike Corriero,
Emrah Elmasli and Mikko Kinnunen

tackle the topic:



Inbroductlion

Touching on a subject that involves some
architecture for a speed painting can either

be extremely simple or extremely difficult;

it all depends on how you handle it. If the
architecture is meant to be abstract it’s likely you
may more easily get away with a lot of technical
details. If you choose to produce a more modern
or less complex style of architecture you can
make it easier on yourself with creating a few

quick custom brushes.

Fig.02

Fig.03a

As a first step you can see | have just set up my
canvas with the horizon line, a couple of simple
perspective lines and a base for the water and
sky. To the right is a reference image that,
although won't set the basis for my designs,

will just help keep me on track when working
quicker than usual. Then | have just set up a

small colour palette to sample some hues from,

instead of going back and forth to the Colour

Picker window (Fig01).

Under the brush presets you can adjust a lot of
the settings to get endless effects. This is just
a simple brush | use a lot, called an “Airbrush
Pen Opacity Flow” brush; with the brush shape

flattened and the scatter option applied it will
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serve as water ripples. You can also apply
Colour Dynamics and play around with the
brightness and contrast and the two colour
boxes, so you'll get a nice mixture of values
and colour shifts without switching your settings

(Fig02).

Only a few minutes in and I've laid down a quick
base for the water, light for the sky and some
clouds. This will be worked on top of and always
kept as the background layer with the simplest
of details and the main base. As | laid the water
lines down | made sure just to keep a couple of
layers and size variation in perspective and in

line with my grid (Fig03a).

The colour palette can be seen in Fig03b.
Producing a colour palette like this is sometimes
much more affective than randomly choosing
colours off of the Colour Picker window. All | did
was take a photo that had a nice colour scheme
that | wanted to apply to my painting, added a

quick smart blur and the pinch filter.

Fig.04b

Quickly laying in the large main elements in

the foreground, I'm using a custom brush from
a set of construction boxed brushes | made

for this very purpose. A quick and easy way to
produce a speed painting involving architectural
designs such as buildings is by laying down

a perspective grid and using custom brushes.
I've set the Brush Presets so that the spacing
of my brush is far enough apart to produce a
kind of pattern effect. Just click one spot on the
canvas then hold shift and click where you want
your brush stroke to head. You'll get a perfectly
straight line, and with the spaced brush it will

give you an interesting design effect (Fig04a).

The brush list is a quickly created group of

boxed brushes. They were not all used but it's
nice to have them handy so that when you begin
painting you have most elements and shapes
already set up . The presets have been kept

off because with all of these brush shapes | am
playing around a lot with the angles, the spacing
and the sizes to produce my buildings and
bridges (Fig04b).

On a new layer some small buildings and
minimal detail are added to the far background;
notice as the buildings are pushed back further

the value has become lighter and details are
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lessened. I'm keeping each plane of buildings
on their own layer for when | produce the

reflective effects in the water (Fig05).

I've started to beef up some of the details on
the buildings, mainly in the background first of
all, as | start to produce reflections and water
ripples. A very quick and easy way to produce

a reflection is to simply copy the layer and flip it
vertically, then just lower the opacity, darken the

colours and overlay a few water ripples. Usually

keeping the base lighter around the object
where it connects and meets the water will help

distinguish the reflection from its origin (Fig 06).

Here you can see how I've copy-flipped the
buildings after their details; the bridges and
windows were added and then set the reflective
layer to a lower opacity. Checking out the
painting at 100 percent resolution you would
see how choppy and simple the water effect

is, as shown in Fig02. Increasing the size and

lining the base of the buildings with a more
scattered version will help provide a splashed
look (Fig07).

At this point | have flipped the painting to check
the composition and decided it would be more
interesting to cut down the second foremost
building so that we can see the base swallowed

up by the flooding waters (Fig08).

Here | have just utilised one of my custom
brushes to lay in some foreground bridges.

All throughout the painting process I've been
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keeping most of this monochromatic and will

apply a touch of additional colour towards the

next few final stages (Fig09).

Once most of the painting has been completed
I’'m just going to do a quick level adjustment. It
doesn’t always work, but using the Auto Levels
option can quickly adjust the values and might
produce an affective change. In this case |

like what it has done and will keep most of the

changes it made (Fig10).

Coming down to the final stage here, what
you're seeing is just some colour applied on a
new layer set to Colour, then using my colour
palette I've just painted some warm lighting in
the background and pumped up the saturation
in a few key areas. The entire painting was
widened on the edges so as not to lose some
elements when | decided to give a tilt to the
composition, adding a bit more dynamic to the

perspective (Figl1l).

dinal louches

Final steps taken to bring this speed painting

to a final image included the addition of some

Fig.11

Fig.12
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important details for scale. I've added railings
and stairs to the bridges, touched up some
of the rooftop textures and lighting, added a
few figures in the foreground, some satellites
for communication, as well as a billboard.
Last minute adjustments to the values and
saturation are made specifically to the sun,
and this painting of a flooded, high, sky-rise
city connected by makeshift bridges, in what
has become a near future disaster scene, is

complete (Fig12).

For more from this artist visit:

Or contact:



http://www.mikecorriero.com
mailto:mikecorriero@gmail.com
http://www.2dartistmag.com/tutorial_resources/issue_023_nov_2007/tutorial02.zip

As the first step, | open up a new canvas in

Photoshop CS3 and select the Gradient Tool (G)

to create a sky colour gradient to achieve a feel
for the painting. Starting to paint on a full canvas
is better then painting on an empty canvas. |
preferred a purple and grey combination for this
painting, but it would be nice as blue and pink, as

well. It's your choice really (Fig01).

dlep 2

Then | start blocking the colours in with a bold
brush. | paint in the silhouettes of the buildings
very roughly. | add some tall buildings to the far

distance to achieve a nice depth of field feel, as

well. | never zoom in at the first step. | always
paint at 25% or 50% percent. | also need to get
the composition right in this step. It's not easy to

fix it later on (Fig02).

dlep 3

| start to add some colours to increase the
saturation and | also apply the main light
source from the left hand side. This is a speed
painting so the time is important. The aim is

to get satisfactory results in a short amount of
time. So, my brush strokes are very fast. | was
planning to finish the painting in an hour, but |

decided to put some more details on it (Fig03).
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dlep

Now the rest is just adding the details and
adjusting the colours. | need some contrast

and colour richness in my painting, so | create
some adjustment layers like Curves and Colour
Balance to adjust the brightness, contrast and
colours (Ctrl + M; Ctrl + B). Then | paint in some
dramatic clouds. A mixture of purple, orange
and yellow would be good for this. | used some
custom brushes that | created whilst painting

them. The rest of the painting needs a lot of



detail, so | just paint in a lot of minor details on
the building. Any brush of your choice would do

(Fig04a & b).

dinal

As the final step, | zoom in and add little lights

and details of the flood verses the city. To make
the lights glow, | create a new layer and change
the layer properties to Colour Dodge. Then |
select a dark orange-ish colour and paint them

in with a default brush.
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In this Speed Painting tutorial I'm going to

explain a little about the use of 3D tools in

the process of designing an image. Most of

the best 2D artists I've met do not like to use
3D that much. Many won't even touch these
applications for whatever reasons. | was one of
those guys, until | was forced to move into the
3D world when | got my first, proper job in the
games industry. I'm going to show a process
that is almost invisible in the actual finished
image, yet helped me a lot when nailing down

the composition of this speed painting.

Juick (omposilion

In a matter of minutes (or seconds, depending) |
create a quick sketch which includes most of the
relevant compositional information regarding my
painting. | start off with a long, cubic shape on
the left, which will eventually become my major
makeshift bridge, as suggested by the title. I'm
not worrying at all about screwing things up at

this point. It's always better to work intuitively

in the beginning, unless you're working under
the very specific constraints of a professional

assignment (Fig01).

The Dneadfful 30 Pari

Having envisioned the basic premise of the
composition in my mind, | start putting together
a scene of very simple box geometry in 3ds
Max. I'm not going into specifics of any 3D
application here, as there are better tutorials for
that. | basically just create a flat ground plane,
a few repeated box shapes, and a camera
setup with a wide-angle lens which suits my
needs the best. Then | put in two light sources
from opposing directions, with the sun being

the stronger one. The other would be the fill
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light from the sky. | don’t use any heavy global

illumination-type settings which would make the
image take a while to render. | hit the render

button and make sure | have enough resolution
so that | won't get too much pixelation (aliasing)

around the edges (Fig02).

Blocking in the (obsuns

After my 3D layout is finished, | start glazing
colours on top of it in Photoshop. | use a mixture
of opaque and transparent layers whilst trying

to find the kind of colours I'm intending to use

in this piece. My approach is very experimental,
and I'm not afraid to use tools like the Selective
Colour adjustment layer to find the right tones.
This time I'm going for a very stylised red and
blue palette. | proceed with the colouring,

always thinking in warms and cools (Fig03).

This is the most defining stage in terms of
the final style of the image. | go for this rather
graphic and painterly style, with strong shadows

and a lot of saturation. | save a version of

the image as a .tif file, and open it in Painter
Essentials 2. It's a free app. that came with my
Wacom tablet. Basically, any version of Painter
has this great brush engine which is good for
blending. | start using the Palette Knife brushes
to soften my rather straightfoward and edgy
Photoshop colouring. There isn't really one

way to do this; you could achieve the same

result without any 3D, by using more traditional
perspective drawing, and you might do the
blending with some custom smudge brushes in
Photoshop. | just like to shuffle my software a bit
and use everything | can to the full extent. It's
all about getting your creative vision across, and
you shouldn’t let the sometimes clumsy digital

tools hold you down!
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Scanned Textures to your 2D Artwork

Ceanned Texburps

L0 A 2d arork
Orealed In:

Photoshop

Inbroductlion

This is a guide for beginners, taking you through
the process of scanning real world patterns from
such elements as feathers to tinfoil, as you'll see
in this tutorial. I'll explain how to get the most out
of your textures, how to save them as a texture
set and how to apply them in various ways to an
object that you are painting.

Ilep. o1

You can create a texture from practically
anything; what I'm going to focus on here
though are textures you can draw and scan, as Fig02

well as household items that you can take from
the kitchen, bathroom or living room. Some or
most of these items you may already have and
you can find lying around the house; others you
can create, like the crosshatch drawing. The
five textures I've used are crumpled tinfoil, a
rubber grip bottle opener, a freehand crosshatch
drawing, feathers used for fly tying, and an

ordinary bathroom hand towel (Fig01).

dlep 02

Once you scan in the item, lay it flat on your
scanner and choose Greyscale at 300 dpi for
a large resolution. The next thing you'll need to
do is to crop the image so it has as few flaws
in variation as possible - you want to make the
texture appear as a pattern. Next you're going
to go to Image > Adjustments > Levels; in the

@e[®)] Levels box that opens up, adjust the black and
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white values to boost the texture of the image.
The darker and lighter your values are the
better the texture will work. Do this by dragging
the black arrow to the right to make the blacks
darker, and the white arrow to the left to make
the whites lighter. | have done this step for each

of the five textures (Fig02).

dlep 03

In some cases, like for the crosshatch texture,

| just used the Stamp tool to copy and replicate
portions to expand the size of the texture and
keep it from repeating the same pattern. This
helps instead of wasting too much time drawing
it all out (Fig03).

Ilep o

Now that | have my texture scanned, the levels
adjusted and everything’s clean and seamless,
it's time to save it as a texture. Click on Edit >
Define Pattern > then save the pattern with any

name you wish, i.e. “Crosshatch” (Fig04).

dlep o5

If you'd like to test your pattern, grab the brush
tool, head to the top right and click the little
black arrow next to where it says “brushes”. This
will drop down a box with a bunch of options that
you can apply to your brush; in here you’ll find

a box you can tick, called “texture”. You'll notice
a thumbnail image of the texture that is chosen,
which also has a little tick box, titled “invert”,

to switch the values of the texture. Setting the

Scanned Textures to your 2D Artwork &ealiny and W

Fig06

Fig05a

scale to 100% will set the texture to the actual pixel size or dpi (dots per
inch); you can lower or raise the scale to suit your needs. | have it set

to 100%, and the depth at 100% as well, in order to get the most out of
my texture. | find that setting the mode to Multiply also works the best for
clarity and a smooth effect when painting with textures. When you invert
your texture you'll also want to invert or switch the colour from dark to light

by clicking on the double arrow icon (Fig05a & b).
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Scanned Textures to your 2D Artwork

This is just a quick demonstration for inverting

a texture and switching the light and dark

values of your colour swatches. It defines the

texture and makes it clearer; this helps when

concerning lighting an object you are painting

(Fig06).

dlep 07

| created a simple sphere as an object to test

these textures on. | will provide this object in the

tutorial so you can test and follow along with

these steps, as well. To the right you'll notice

after repeating steps 01 through 04, for each

texture or real world object they will all show

up in my texture list. You can access your list

by clicking the little arrow next to the texture

thumbnail. Here you can view each of your
Fig07

textures and save the texture set. Click the

arrow to the right of all your textures and a box
will drop down where you can choose to Save
Patterns. Now, whenever you want you can go
to this same box and choose Load Patterns to
access this set of textures you created (Fig07).
dlep 05
Refer back to step 05 for the use of your
textures, then select the Magic Wand tool,
clicking outside the sphere then inverting your
selection to outline the circle. Using the method
explained in Step 05, you can paint any texture
you wish on to your object. | find that setting
Fig08

your layer above the object to Soft Light mode allows both the texture and

the original values of the object to work best (Fig08).

dlep 09

Another more affective way to produce a texture that will appear to wrap
around an object is to create a new Normal layer above the original
sphere. Select a mid-toned grey and fill the selection on the new layer

with the Bucket tool. Now to apply the texture select Filter > Texture >

e  Texturizer (Fig09).
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dlep 10

The Texturizer box will open; to the left is

your grey selected area and to the right are
your texture options. To the right of the word
Texture in blue is an arrow; if you click it then
an option appears to browse your files for a
texture. To use your textures in this manner
save your original flat texture files as a PSD file
(Photoshop Document) in the presets textures
folder of Adobe’s files. This folder can be
accessed in your program files section of your
computer. Once you browse and select your
texture file it will apply it to the preview box to
the left. Set the Scaling to 50% and the Relief to
10%, then click OK (Fig10).

dlepn
Now that your texture is applied to the greyscale

selection, make a duplicate by dragging the

Scanned Textures to your 2D Artwork &ealiny and W

Fig11
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7 Scanned Textures to your 2D Artwork

layer down to the little icon that looks like a
white square page being flipped. A copy layer
will be made; set the top layer to Overlay at
85% opacity and the bottom layer to Hard Light
at 25% opacity. Right away you'll notice a big
change in the clarity of the texture compared to
painting it on to the sphere. To further define the
pattern and to have it wrap around the sphere,
choose the selection tool and apply the Select
> Invert technique, as mentioned in step 05, to
select the sphere. In the last step here you're
going to select Filter > Distort > Spherize, and
set the Spherize box to 80% in order to blow up
the texture, making it appear to wrap around the
object. Do this to both the Overlay and the Dark
Light layers and you've successfully applied
your home-made texture to an object in a 3-

dimensional form (Fig11).

dlep 12

Shows all five textures applied to the sphere

without the Spherize filter (Fig12).

dlep 13

Shows all five textures applied to the sphere

“with” the Spherize filter (Fig13).

dcanned lertunes lo youn
20 hlwonk

For more from this artist visit:
www.mikecorriero.com
Or contact:

mikecorriero@gmail.com

Fig12

Fig13
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ELEMENTS

RAINSTORM

Orealed In-

Adobe Photoshop 7

The first thing we need to do is to grab some

reference images (I always use Google Images

to search) in order to understand how the

colours change in different weather conditions.

Remember that we are only using the reference

photographs as a colour guide for our painting.

In this tutorial | will show you the steps that

| followed in order to transform this base
illustration (Fig01) into a storm scene, but is
essential that you also practice and create your

own techniques, too.

Our first step is to change the ambient colour of
the entire scene. Let's pick a grey/brown colour
(RGB: 83, 71, 65); this colour is going to give us

the stormy, ambient colour that we are looking

for. Create a new layer (Hard Light 100%) and

fill it with our ambient colour. Do you see how it
changes with only one colour (Fig02)? And this

is only the first step! Let’s continue.

Now we need some clouds. In this step, if you
have a cool cloud picture to hand than you can
use that. If you don’t have one that you can use,
simply make a search for some interesting cloud
images, or take some of your own photographs.
Create a new layer (Overlay 100%) and paste
your cloud picture onto it. Or, if you're feeling
confident, then try doing it like me and paint
your own clouds! Remember that we must only
paint with this grey colour though on this layer,
because we don’t want to dramatically change

our brown ambient colour (Fig03).

www.2dartistmag.com page 112 Issue 023 November 2007


http://www.2dartistmag.com
http://www.2dartistmag.com

s lonmee e

Create another new layer (Normal 100%) now
in order to add some fog to the mountains in the
distance. In a storm scene such as this then fog

is really important.

The image still looks too bright for a stormy day,
so let's darken it a little more. Create another
new layer (Overlay 100%), select a Gradient
tool (Foreground to Transparent) and paint the
layer with a dark colour (RGB: 59, 56, 53). Now
it's looking like a stormy day (Fig04), don’t you
think?

Fig05

We need to add more fog in the distance now, so select a soft round brush

(Size 300; Opacity 50%) and paint on the horizon line (Fig05).

Now it's time to add the rain! To paint the rain | created a simple brush
which is available as a download at the end of this tutorial. So, select a
bright rain colour (RGB: 100, 97, 96) and paint over the entire scene using

the rain brush, trying to put more rain on the horizon line (Fig06).

In a new layer we are now going to add a wet effect to the trash can in the

foreground. With just a few white strokes in the area where the light hits
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the trash can, and a simple reflection/back light
on the back of it, we will achieve a nice wet-look
effect (Fig07).

To increase the wet/rain effect we have to add
water splashes, too. | created another simple
brush for this effect, as well (this brush doesn’t
have any special configurations). So, select the
brush, create another new layer and paint in the

little rain splashes around the trash can.

We still need to add the reflection from the farm
and the trash can over our wet floor. This step
is very important so pay attention here. Create
a new layer and merge the visible layers (Shift
+ Ctrl + Alt +E). Now you have all the painting in
one unique layer, but you can still see that other
layer are there, too! Select the farm and the
trash can with the Lasso tool, Ctrl + J and we
will automatically obtain a copy of our selection

in a new layer (Fig08).

Now go to Edit > Transform > Flip Vertical,
move the duplicated trash can and farm to

the base of its original ones, and erase the
edges with a soft round brush. You should
obtain a similar result to what can be seen in
Fig09. To increase the reflection, change the
Layer properties to Overlay; this will create the

reflection effect on the floor.

Let’'s now add our lightning to this storm scene!
First of all, we have to darken the top of our
painting a little more, because the lightning

needs some contrast.
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Create another new layer, pick a darker colour
(RGB: 65, 61, 59) and paint again using the
Gradient tool over this new layer. Change the
properties of the layer to Overlay and reduce
the Opacity to 50%. Now we can easily paint a

couple of highlights over this dark sky.

To create the lightning in this storm you'll have
to paint an irregular shape in a bright colour; you
can then smooth the top of the lightning, as if it

is coming from inside the clouds (Fig10).

Create another new layer (Normal) and add
the first lightning glow (yes, we will add another
one in just a couple of minutes) with a soft
round brush. To increase the light effect, add a
reflection to the base of the clouds. Create an
Overlay layer and paint the second glow effect
with white over the lightning. You can see the
difference of some lightning with a glow and

without, in Figlla & b.

And for the final step we are going to add a
technique that | always use to add texture to a
painting and increase the shadow. Create a new
layer and merge all the visible layers again. Do
you remember how to do this? Shift + Ctrl + Alt
+ E. Now we have the entire scene merged, go
to Image > Adjustments > Threshold and play

with it until you obtain a result similar to Fig12.

Do you see how it looks as and old ‘ink
painting’? Well this technique is good in order to
see if your painting has good light and shadow

work.

Now select this new black and white layer and
change its properties to Multiply. We have to
reduce the Opacity to 5% in this particular case,
but remember that if you use this technique then
the maximum opacity is something like 15%,
because you don’t want to cover all of your cool

paintings.
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Orealed In: Pholoshop
Photoshop Creative Suite

How T Paind T ips Wonlh
M. '

So you have painted this lovely woman with

beautiful eyes and an even more lovely face,
have maybe even used one of the current
tutorials to attach some wonderful hair to her,
and now realise what you have so patiently
avoided, until it could no longer be ignored...

take a deep breath... the lips!

Besides all mentioned, the lips is what really
makes a female illustration, especially when
you're looking for the kind of “kiss me” pop
out lips which may drive one or another man
crazy whilst observing them. To learn painting
lips at their best, | have decided to make up
two examples for you in two different colour
schemes and angles, so that you have the best
base for your future female paintings. We also
have an immense number of working steps
this time, which means that | cannot add as

much “jibber jabber” to the whole article as | am

usually used to, but | think the pictures do speak for themselves enough to

survive a less detailed description than usual.

Ceample 1

Step 1 — The Base For The Lips

Alright, let’s start. Pick the red colour of your desire and a hard-edged
airbrush - Spacing 0%, Opacity 100% and the size of your desire - to paint
in a basic lip shape, which you will then separate with a curvy line of dark

red. So you have an upper and lower lip now, in a very basic shape. To
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give the lips an illusion of depth, it works best
to make them cast a shadow (see Fig01) and to

add some highlights to the surrounding skin.

Step 2 — First Highlights

Stick with the hard-edged airbrush - the Opacity
can be between 90% and 100% - and attach
the first highlights to the lips with a bright red

or a soft pink. You can also pick a red which is
slightly darker than the basic reddish colour of
the lips to attach some at the lower side of the
upper lip and at the lower side of the lower lip
(Fig02).

Step 3 — Further Highlights
Now we're going to add some “pop out”

highlights. Still using the hard-edged airbrush,

but of a smaller size, choose one part of the

lips to which you will attach a very bright white
highlight and then randomly spread some other
highlights on the upper and lower lip. We will
merge the lip layers 1, 2 and 3 now to save
working capacity. Simply press Ctrl + E whilst
you are on the lips layer 3 and it will merge layer
3 with layer 2. Whilst you're on layer 2, press

Ctrl + E again to merge it with layer 1 (Fig03).

Step 4 — Soften It Up

In step 4 we will create a new layer (Ctrl + Shift
+ N, or Layer > New > Layer) and pick the soft-
edged airbrush with an opacity of 30% to soften
the “edgy” borders between each colour, which
were caused by the hard-edged airbrush. Pick
your basic red again to work near all highlighted
areas of the lips. The darker red is for the lower
part of the lower lip which is closest to the
shadow, and for the lower part of the upper lip
which is closest to the line between both lips
(Fig04).

Step 5 — Working On First Detail

Now it's detail time! Pick the hard-edged
airbrush again and set it to a rather small size
of your desire. Create a new layer and attach
many little white dots and strokes to the lips.

The strokes should be bent so that they follow
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the roundness of the lips. It also works best if

you paint dots which vary in size, to avoid the lip

structure looking boring (Fig05).

Step 6 — Soften It Up Again

Create another new layer and pick the soft-
edged airbrush again. The size should be as
seen in my example (Fig06), compared to the
size of the lips; the opacity should be no more
than 30%. Carefully work over the lower part
of the highlighted areas. You can compare it
to step 5 if you want: do you see how the little
strokes and dots seem to form a clearer lip

structure now?

Step 7 — More And More Detail

If you want, you can merge the layers from
steps 5 and 6 now by pressing Ctrl + E, to avoid
being overwhelmed by layers. Don't forget to
create a new layer for the detail which we will

be adding now. You can either take a small,
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hard-edged airbrush, or a small, speckled brush

(like the one we created in the hair beginners
tutorial in Issue 019 of 2DArtist) and paint many
little whitish strokes and dots on the lips. As you
can see, | did this very randomly in Fig07. Don’t
worry, it'll look good in the end! You can also

add some small highlights to the lips (Fig07).

Step 8 — The Final Touch Up

Pick the soft-edged airbrush again - opacity set
to no more than 30% - and set it to a size which
is the same as in my example, compared to the
size of the lips. Now pick a reddish tone which
is slightly brighter than the basic red which you
have used for the first shape of the lips, and
carefully work over the lower part of the lower
lip. Now pick a whitish tone and carefully add a
few more highlights to the top of the lower lip.

And you're done now (Fig08).

The image, “Red Apple”, from this example
(Final Image), was actually painted for a friend
as a birthday present, called “Desert”. It was
later taken from my private collection to be
adapted for this tutorial. The actual painting
was meant as a homage to the great Catherine

Louis’s ‘Green Apple’ series.

Gample 2

Step 1 — A Base For The Lips Again

Let’s continue with example two, now. This time
we want to paint lips in a % view. Unlike the first
example, which was basically held in reddish
tones, the current example lives from blueish
background tones which hold a contrast to the

pinkish lips and skin tones. So the lips will be set
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up from a basic pinkish colour scheme this time,

again separated with a rather dark red, curvy
line to divide it all into the upper and lower lip.
The brush of choice is, again, the hard-edged
airbrush - Opacity 100% and Spacing 0%
(Fig01).

Step 2 — Adding Highlights

Stick with the hard-edged airbrush again to
attach some highlights to the lips. | have marked
which colours were used for which area on
Fig02. You can also see that | painted some

basic teeth in; they are basically just two big

strokes in a red which is a little brighter than the
red that was used to separate the upper and

lower lip.

Step 3 — Adding Strokes And Dots

What we’ll do now is add some strokes and a
few dots to the lips, which is quite simple but will
make them ‘pop out’ more. Adding some dabs
of highlight will make the lips look glossy. Also,
picking a dark red to carefully work on the lips
with curved lines which follow their shape adds
detail and makes them seem more realistic. You
can also feel free to add a few lines of highlights
to the lower lip to add more detail to them, too
(Fig03).

Step 4 — It's Blending Time Again

Now, since we have so nicely worked in some
detail into the lips, it is time to soften the whole
thing up again. But, first of all, you can merge
all current lips layers to save working capacity,
again. Then you can create a new layer to
work over the lips with the soft-edged airbrush
- Opacity 30%. This merges the colours together
and you will get away from the “edgy vector”
look. It will also take away some of the detalil,
but don’t worry, we'll bring that back in steps 5

and 6 (Fig04).
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Step 5 — Applying More Strokes To Push The
Detail

If you want you can merge the layers again now
by pressing Ctrl + E. Like in example 1, you can
either take a small, hard-edged airbrush, or a
small, speckled brush to paint many little whitish
strokes on the lips. You can also add some
additional highlights to get the lips popping out
effectively again (Fig05).

Step 6 — Finished. This One was Quick!

You can now use the speckled brush, or basically
any hard-edged brush of a very small size, to
paint many little dots in your highlight colour of

choice on the lips, to finish them up.

Now this was a quick one, wasn't it? That is the
good thing about lips: as soon as you attach a
lot of highlights to them, like in example two,
you will get such a great pop out effect that the
eye of the viewer gets mixed up and so won't

recognise the “lack of detail” (Fig06).

How T Paint Tips Wonlh
Nissing, by linne Pogoda
For more from this artist visit:
www.darktownart.de

Or contact:

wpwebmasterin@web.de
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POAnErs

Orealed In:

ZBrush & Photoshop

Tnitial Loncept
The concept illustration ‘Speed Runners’ was a
personal project, mainly geared towards helping
me get quicker results with my concept work.

At the time, | was involved in creating a series
of illustrations based on science-fiction themes
using a ZBrush to Photoshop pipeline. ‘Speed
Runners’ was a direct result of that multi-

platform experiment.

Inspinalion

A little over a year ago | had the opportunity to
attend the Gnomon Workshop, where artists
Barontieri and David Levy had shown the
process for creating their incredibly dynamic
concept art. Part of that process involved the
use of 3D software to model abstract shapes
which could be rendered and later composited
in Photoshop. Although | had already dabbled

with a little 3D illustration, | remember being
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very intrigued by the use of 3D as reference for
creating concept illustrations. Having the chance
to see these professionals at work really created
the initial spark | needed to test the waters on
my own. At that time | was not nearly as flexible
with the use of 3D applications as | would

have liked, so | set out to learn what | could

and settled on ZBrush as my 3D application of
choice, based solely on its small learning curve

and flexibility.

Phocess

When | initially began the illustration, | had
been experimenting with different ways

to design generic ship models in ZBrush
using a technique created by a user named
“SaltaPiedras”, of the ZBrush Central
forums. This technique involved the use of
texture masks which could be used to create

deformations based on hue (Fig01, Fig02,


http://www.2dartistmag.com
http://www.2dartistmag.com

dpeed iunnens oo

Fig03 and Fig04). Essentially, | would begin by
creating a rough model using ZSpheres, and
increase the geometry to very high levels. A
generic texture mask would be applied to the
model and deformations could then be created
using the deformations properties panel in
ZBrush. | took this process one step further by
exporting a high resolution render of my results
and then importing it into Photoshop where the
illustration process would take place (Fig05).

| began playing with ideas for the layout and
decided to have the ships hovering over a
desert-like environment with a backdrop of a
decayed city skyline. Additionally, | wanted to
portray an evening sky which would allow me
to play with some interesting colour variations.
Living in Colorado there has never been a
shortage of breathtaking sunsets that contain
an incredible array of colours, so | decided to
take a note from nature and incorporate colours
that would be found in a typical Colorado sunset

(Fig06 & Fig07).

With my layout and colour palette in place, |
began working on the decayed city. Because

| wanted to concentrate focus on the ships,

| created the city using simple brush strokes
and kept details down to a minimum (Fig08).
Painting the ships was a bit of trial and error.
After cutting out the ships and placing them

in the scene, | wasn’t completely satisfied

with how they sat in the composition (Fig09).
Using the Free Transform tool, | adjusted

the size of the ships until | was happy with
how they flowed inside the space. | then
accommodated the angle of the ships further
by using the perspective lines as a guide. With
the perspective in place, | duplicated the ship
layer multiple times and began playing with
the layer properties. | used several layers in
Multiply mode to adjust the contrast of the ships
and began to establish light and shadow areas
before flattening the ship layers to one single
layer. Colours were painted in several stages
using Multiply mode on separate layers, and
painting opaquely directly on the ship layer
(Fig10). White thrust and smoke were added
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to the rear of the ships, as well as action lines
on the floor to illustrate the sense of rapid
movement. Final details were incorporated with
the creation of swirling cloud formations and

lighting effects.

dinal Thoughls

Altogether this concept illustration took less than
two hours to make; however, there are a handful
of issues with the image, including problems
with perspective, multiple light sources and

lack of overall cohesiveness. Whilst the idea

Viaking O -

behind this type of illustration was to design
and execute a concept quickly, | always make a
habit of creating mental notes regarding these
type of mistakes so they can be avoided when
the time comes to take concept art into a fully

developed illustration.

Joel Lanls

For more from this artist visit:
www.joelcarlo.net
Or contact:

joelcarlo@gmail.com
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magazine: a downloadable monthly magazine for
concept art, digital & matte painting for only UsS
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Inboduclion

With having a traditional art background most

of my digital work has been primarily 3D, with
. . . Fig01
only compositing and colour correction using

Photoshop. But with this project my goal was
to rely on both 3D and 2D elements equally,
creating a true hybrid piece that would utilise
the strengths of both approaches. First | had
to find a concept that would align with my
goal. | immediately knew | wanted to create
a landscape, and I've also wanted to tackle a

primitive, industrial environment. Many ideas

surfaced but the ones | gravitated towards

Fig02a

revolved around civilizations such as ancient
Egypt where thousands were forced into hard
labour to build the pyramids. Other ideas that
came to mind were the horrible conditions
and the same slave-like scenario of the Nazi
concentration camps. In the end, | decided to
combine imagery from both of those topics.

Another goal | had before laying any paint or

Fig02b| vertices down was to give a sense of ambiguity

to the scenario that would allow the viewers

to pull their own conclusions. | envisioned this

landscape in a desert-like environment with

a heavy, dusty haze that would resemble an
Egyptian-like atmosphere during a dust storm.
There probably wouldn't be a cloud in the sky
and any water source would have dried up a
long time ago. Then focusing on the civilization,
| wanted to place them in time during the age of
our Industrial Revolution to allow some of that
concentration camp imagery to peek through.

As for the creatures that were forced into hard
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labour, they had to have strong lungs and even
stronger skin and muscles to survive in this
chaotic world. Perhaps mixed with selective
breeding from the “master species/race” of the
planet, they would weed out the weak and only
keep the strong. With that in mind, | wanted to
call back to the ancient Egyptians and have
these slaves carrying huge pay loads, perhaps
without even the help of machines. Now I'm
ready to dig up some references and begin

sketching some ideas out.

Jkﬁﬂk

Even though | wanted this project to develop
extremely quickly, I still went through my usual
process of finding some references, doing some
thumbnails, and working on the final piece. |

first dug through my photographic library and

came across an image from a film shoot (Fig01).

The cliff in the image gave me the idea that the

master species would try to build their “factories”

in the shadows and valleys, perhaps suspended
off the ground to allow cooler air/water from
below ground to siphon up. | also wanted to
include an ominous pile just outside of the
factory for the viewer to imagine what it could
be. Then, using that image as a background, |
began sketching on top of it using Sketchbook
Pro with a Tablet PC. After a few minutes on
thumbnails | began spending an hour refining
one of the images first in Sketchbook Pro, and

then colouring in Photoshop for another hour

e o R

Figo4

Fig06

(Fig02a - 02c). During this stage, | created

a bridge to the factory that would allow the
“slaves” to enter by a long, gruelling march.
Once | was happy with the overall composition

and mood | began on the final painting.

To help with perspective and composition, |
decided to block out the scene quickly using
3ds Max and then paint over the geometry in

Photoshop. Using boxes and other primitives, |
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constructed the factory, walkway and “cargo” for
the slaves in about an hour (Fig03). A plane with
paint deformation on it was used to simulate

the terrain. | also created a Z-pass and several
object mask images from the 3D scene to aid in

painting.

zkﬁﬂ]:

My first step in the painting process was

playing with the global colour and general light
direction, using a soft airbrush and gradients
above the 3D image on a layer set to Overlay in
Photoshop. One thing | found helpful was “up-
rezing” my coloured thumbnail, heavily blurring
it, then playing with different layer modes
composited over the top. | also integrated the
Z-pass at this stage to simulate some of that hot

haze (Fig04).

Zkﬁﬂ‘l:

Once | was happy with the tonal range and
colour of the whole piece it was time to start
the rough, impressionistic details. My technique
for rendering quickly and painterly involved
using simple, round, hard brushes with the
Opacity set to 50-70% for light, shadows,

and additional surface details. Then | set a

layer set to Overlay and pasted in appropriate

textures for each material and buildings from
my personal photographic library. Then, using a
custom smudge brush (Fig05) with the Strength

set to 100% and with the “all layers” option

on, | painted on a new layer, allowing me to
backtrack or erase my brush work if needed
(Fig06). This part was definitely the most fun
and proved to be very quick in achieving an

impressionistic style.
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The entire image was completed using this
process over and over again until it was done.
The painting process took a little over 5 hours
(Fig07a -c), with another 2 hours of additional
tweaking and colour correction to create the

final image.

Hopefully this breakdown was helpful in driving
into my thought process and techniques for
realising and rendering a concept in a relatively

quick amount of time.

Thanks for reading!

Brian Recklenwald
For more from this artist visit:
www.brianrecktenwald.com

Or contact:

breckten@gmail.com
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MASTERS

VOLUME 2

With the release of 3DTotal’s new book,
‘Digital Art Masters: Volume 2’, we have

some exclusive chapters for you...

The book is more than just an artwork
book, as not only does it feature
full-colour, full-page images, but each artist
has described in detail the creation process
behind each published artwork, in their

own words, especially for this book.
This month we feature:

‘Bang On Time'

by Michael R Smith
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Jason (Wei Che) Juan
Morgan Yon
Midway Games

Luis Melo

Sketchbook of Matt Dangler

What artwork has moved you

emotionally/mentally, and why?

Custom Brushes

Speed Painting
Elements Weather Series

Snowstorm!
Sallenies

10 of the Best images featuring

Kerem Beyit

Kieran Yanner

Tom Arthur Opasinski

Tiberius Viris

Teng lin

Pascal Raimbault

John Wallin Liberto

Robin Olausson

Marcin Jakubowski

Daniel Ljunggren

go to www.2dartistmag.com for full
details and to purchase current, back

issues and 6 & 12 month subscriptions

Image by John Wallin Liberto
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3dcreative REGRULTMENI

STUDIOS

Krome Studios is Australia’s largest
game development studio. We now
boast 4 project teams, over 200 talented
people and an increasing presence in the
worldwide game development industry.

We are always looking for talented and
experienced game developers to join
our teams.

Ifyou share our passion for games
and would like to work on high
profile titles in conjunction with
the top 5 publishers in the world.
— We want to hear from you!

Formore information on available
positions and how to apply
please visit our website:

www.kromestudios.com

an Tiger and the Krome Studios logo are tradei < S Universal Interactive, Int oand related
Universal Interactive, Inc. All of a g perty of their respective owners. All Rights Reserved
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REGRUIEMEN el res

Give yourself a flying start

As a specialist recruiter to the video games and interactive entertainment
market, Aardvark Swift are committed to help you find your dream job.

Whether you are an Artist, Animator, Designer or Producer,
we have the perfect role available for you in what is a fast-
paced and exciting industry. We have roles both in the UK
and abroad (as far a field as Australia!), so if you are looking
for your next exciting challenge, and want to enjoy an
excellent salary, benefits and work environment, give us a
call and we’ll be more than happy to help you out!

www.aswift.com 01709 876877

Aardvark Swift Recruitment Silicon House, Farfield Park,
Rotherham, South Yorkshire S63 5DB
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REGRUITMENE
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WOULD YOU LIKE TO ADVERTISE YOUR JOBS HERE
FOR FREE?
CONTACTI lynette @zoopublishing.com
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/00 PUBLISHING Aboutus

PUBLISHING

Is a company publishing downloadable online
magazines. We are based in the West Midlands
in the UK. Zoo currently produces two online
downloadable magazines: 3DCreative and
2DArtist. Zoo's intention is to make each issue
as full of great articles, images, interviews and
tutorials, as possible. If you would like more
information on Zoo Publishing or our magazines,
or you have a question for our staff, please use

the links below.

CONTACT INFORMATION

www.zoopublishing.com
www.3dcreativemag.com
www.2dartistmag.com

Editor > Lynette Clee
lynette@zoopublishing.com
Lead Designer >Chris Perrins
chris@zoopublishing.com
Content Manager > Lynette Clee
lynette@zoopublishing.com
Marketing > Lynette Clee

lynette@zoopublishing.com

PARTNERS

If you have a CG Community website and would
be interested in reselling 3DCreative or 2DArtist
magazine, please contact Lynette Clee on the

email address above.

W

3Dtutorials.sk

chcmnel.com

EI..I.EI DIVISIONMODELING.COM
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